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Abstract: The release of an airborne hazardous substance nearby or with-
in a military facility can threaten the life or safety of government personnel 
and the general public. Vulnerability assessments using simulants and 
sensors are expensive and may interfere with normal facility operations. 
Simulation modeling technology offers a possible method for understand-
ing how airborne hazardous substances may circulate inside and around 
any specific facility affected by an attack or accidental release. Improved 
understanding of airborne threats could shorten emergency response time 
and minimize casualties at the site. A computerized simulation tool called 
CBRSim, developed under an earlier U.S. Army research program, pro-
vides an environment for creating and testing models of release patterns 
for airborne weaponized agents within or nearby a targeted facility. This 
report describes the CBRSim tool and explains how it could be used to as-
sess chemical, biological, and radiological (CBR) weapons effects for spe-
cific facilities. The discussion includes the results of case studies and simu-
lations run during a workshop for military installation stakeholders 
presented at Fort Carson, CO. 

Demonstration results indicate that CBRSim is not sufficiently developed 
to provide reliable situation data in real time, but offers benefits as a train-
ing and education aid for facility managers and first responders.  
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cubic feet 0.02831685 cubic meters 
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feet 0.3048 meters 

gallons (U.S. liquid) 3.785412 E-03 cubic meters 

inches 0.0254 meters 

miles (U.S. statute) 1,609.347 meters 

miles per hour 0.44704 meters per second 

square feet 0.09290304 square meters 

square inches 6.4516 E-04 square meters 

square miles 2.589998 E+06 square meters 

square yards 0.8361274 square meters 

tons (2,000 pounds, mass) per square foot 9,764.856 kilograms per square meter 
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1 Introduction 

1.1 Background 

Annual vulnerability assessments and realistic force protection exercises, 
including emergency response planning, are required by Department of 
Defense (DoD) policy. The military services and installation commanders 
are required by Department of Defense Directive(DoDD) 2000.12 and De-
partment of Defense Instruction (DoDI) 2000.16, standard 26, to conduct 
a higher headquarters vulnerability assessment of their installation’s anti-
terrorism (AT) programs. 

A terrorist’s release of a chemical, biological, or radiological (CBR) agent 
can infiltrate heating, ventilation and air conditioning (HVAC) systems, 
and quickly contaminate a building. A capability is needed to simulate 
CBR attacks, and to understand their impact on personnel, buildings, crit-
ical facilities, and other assets. An easy-to-use modeling and simulation 
tool, that provides visualization of the effects to buildings from an external 
release of such agents, could potentially provide support to force protec-
tion personnel, emergency responders, and facility planners.  

The U.S. Army Engineer Research and Development Center, Construction 
Engineering Research Laboratory (ERDC-CERL) developed an operable 
prototype tool for these purposes called CBRSim. As part of the Fort Fu-
ture Virtual Installation project in 2005, Argonne National Laboratory was 
retained by ERDC-CERL to implement the CBRSim software, to develop 
the industrial chemical and leaky box modules, and to integrate them with 
the HPAC modules. 

1.2 Objective 

The objective of this project was to demonstrate the CBRSim application at 
a U.S. Army installation, and to provide its staff with the capability to run 
additional simulations. 

1.3 Approach 

ERDC-CERL collaborated with Fort Carson personnel to get project buy-in 
and to identify use cases. Ten buildings of interest were chosen for further 
focus on interior contamination. The team collected available GIS data, 
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and established a Fort Carson model. ERDC-CERL also obtained assis-
tance from researchers at the National Institute of Standards and Tech-
nology (NIST) to develop a methodology for assigning estimated building 
air change rates for the CBRSim model. 

A workshop was conducted at Fort Carson for the force protection person-
nel to develop use cases, to run simulations, and to provide training on 
system operation. The lessons learned through the Fort Carson implemen-
tation were documented, in order to achieve successful technology transfer 
and application to other Army facilities. 

A CBRSim User’s Manual was developed for use at all Army Installations. 

1.4 Scope 

This project documents the demonstration of an alpha version of a soft-
ware application program. The software is not considered to be fully oper-
ational for real-world threat modeling and simulation  

1.5 Mode of technology transfer 

The alpha version of CBRSim is not appropriate for fielding as a real-world 
simulation modeling tool for Army installations. However, it offers poten-
tial education and training benefits for first responders and installation 
Force Protection Officers by reinforcing the need to adhere to established 
emergency response protocols and visually adding to their insights about 
the effects and aftermaths of chemical, biological, or radiological weapons 
attacks. 

The version of CBRSim documented in this study is considered suitable for 
transition to advanced developmental research an appropriate technical 
proponent. 
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2 CBRSim Development and Application 

2.1 Program overview 

The Defense Threat Reduction Agency (DTRA) has developed a software 
tool called Hazard Prediction and Assessment Capability (HPAC), which 
allows a user to enter release parameters, run an atmospheric dispersion 
model, and visualize contour plumes of human health effects of the con-
taminated outdoor air on an overlay of the user’s installation (DTRA 
2002). The original system focused primarily on Weapons of Mass De-
struction analyses to be used by operational commands.  

The CBR Modeling and Simulation (CBRSim) program provides a simpler 
front-end tool as a subset of the HPAC system. The tool allows a user to 
model the effects of a chemical, biological, or radiological incident within 
an installation, and displays the effects of using a shelter-in-place strategy 
on contaminant levels within buildings and their relationship with time.  

The focus of CBRSim is to analyze hazards at and around an installation. It 
offers the more commonly used HPAC incident models and includes 
smaller-release scenarios such as an aerial spray release, or a tanker re-
lease/explosion. CBRSim also adds a leaky box model to simulate the shel-
ter-in-place strategy, and to display its effects on contamination levels 
within buildings. The system can easily be set up to read ESRI (ArcGIS) 
shapefiles of any installation, including building footprints, road and rail 
networks, and topography. These files can be supplemented with building 
air change rates that are used to model outdoor air entry into the build-
ings. 

CBRSim incorporates source terms for 23 weaponized agents (e.g., anth-
rax and sarin) from the HPAC Tool, along with an additional 44 toxic in-
dustrial chemicals (TICs), such as chlorine and ammonia. Data from ex-
ternal sources, including user input, provides initial state variables, such 
as amount of contaminants released, release rate, location, duration of the 
release event, and local meteorological information.  

The basic work flow for the CBRSim is to define the source characteristics 
of a release, execute the air dispersion transport model, and analyze the 
health effects plots. The contour plots available are the 15-minute interval 
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concentration plot, total integrated concentration (surface dosage), and 
surface deposition (see section 2.3, “Output”). 

 

Figure 1. Processes used in the CBR Simulation. 

Figure 1 shows the processes within the CBRSim system. DTRA’s HPAC 
system (DTRA 2002) was designed for multi-user server interaction, and 
the architecture is such that its graphical user interface (GUI) desktop 
client is totally detachable. This allows the CBRSim system to make calls 
directly to the HPAC server components. The inter-process communica-
tion protocol that was chosen for calling the HPAC server application pro-
gram interface (API) was CORBA (Common Object Request Broker Archi-
tecture). There is an Interface for Consequence Effects (ICE) layer API 
(ICI, 2003) so any external process needs to communicate with ICE in or-
der to access the HPAC server functionality. The ICE layer also uses 
CORBA as its communication protocol. The CBRSim spawns its HPAC 
Model Controller as a separate process. The process wraps the subset of 
calls needed for this particular application. The HPAC Model Controller 
communicates with the CBRSim client via Java Remote Method Invoca-
tion (RMI), and packages data and makes the calls to ICE via CORBA calls. 
CORBA and Java RMI have the same purpose: to allow calling of methods 
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within separately-running processes on a computer (or distributed com-
puters). 

Whereas the HPAC/ICE and HPAC Model Controllers run as external 
background processes waiting for input via CORBA or RMI, respectively, 
the CASRAM Model Controller and Leaky Box Models are written as in-
ternal Java models that reside within the CBRSim client process. The 
CASRAM and SEBMET models are existing models developed by Argonne 
National Laboratory (ANL) that are written in Fortran. As will be ex-
plained in the next section, CASRAM is the incident model for aerial spray 
releases and tanker/truck releases and SEBMET is the meteorological pre-
processor that creates consistent meteorological parameters for use in 
both CASRAM and HPAC. In order for a Java program to call out to 
another language model, such as a Fortran model, it calls out to the Oper-
ating System and executes the model externally when needed. The input 
files for the Fortran models are written out from the user input in the 
client GUI, the model(s) are executed, and then the output files are read in 
and the results packaged for the HPAC model’s execution. This processing 
is all invisible to the user.  

2.2 Components 

There are four major components to the CBRSim tool: Incident characteri-
zation modules, environmental data, air dispersion models and health ef-
fects plots, and an installation shelter-in-place protection strategy model. 

2.2.1 Incident characterization models 

Incident characterization models let the user describe the what, where, 
and when of a Nuclear, Biological, or Chemical (NBC) release and the 
models then calculate the associated material parameters needed to feed 
an atmospheric dispersion model. Three of the incident characterization 
models are included from HPAC. However, CBRSim employs a simplified 
user interface derived from the more sophisticated, but needing more ex-
pertise to configure, version within the HPAC system. A fourth incident 
model used is the CASRAM Model. 

2.2.1.1 HPAC Models 

The included HPAC models are: 
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• Chem/Bio Facility (CBFAC) – Used to calculate the amount of agent 
released to the atmosphere following a targeted attack at a chemi-
cal/biological facility. The user selects the calculation type, damage se-
verity, agent, and mass of agent; 

• Chem/Bio Weapon (CBWPN) – Used to calculate the amount and dis-
tribution of an agent released by a chemical or biological weapon. The 
user specifies the munitions type, weapon delivery system, agent, mass 
of agent in weapon, and the release altitude; 

• Radiological Weapon (RWPN) – Used to calculate the explosive-driven 
dispersal of radiological materials. The user selects the high explosive 
mass, material type and form, radioactive material mass, calculation 
radius, exposure and cloud dose. 

As pointed out previously, the HPAC incident models were focused on 
weapons of mass destruction, and require advanced expertise in setting up 
and selecting the numerous options when running in the original HPAC 
GUI. The CBRSim simplifies the user input by selecting defaults and ex-
posing only the most necessary options. Therefore, the CBRSim user need 
not be an expert in CBR weapons in order to study the effects of an attack 
or accident on the installation. Detailed descriptions of the HPAC incident 
models, CBFacility, CBWeapon, and RadWeapon, can be obtained from 
the HPAC User’s Manual (DTRA 2002). 

2.2.1.2 CASRAM Model 

The CBRSim system includes an incident model called Chemical Accident 
Statistical Risk Assessment Model (CASRAM), written at Argonne Nation-
al Laboratory, to define chemical and biological releases from a tank car 
leak/explosion, or a spray release from a small plane. The CASRAM mod-
ule also includes toxic industrial chemicals that are not included with 
HPAC for use in modeling the types of accidents or incidents at facilities 
that are more likely to occur. The CASRAM output is fed into the Second-
order Closure Integrated Puff (SCIPUFF)(Sykes et al. 1998) dispersion 
model within HPAC, and health effects plots are produced for these runs 
just as if they were native HPAC modules. The following section describes 
the physical processing for the CASRAM model. Additional details can be 
found in Brown et al. (2005). 

Materials are shipped or stored as either solids, ordinary liquids, com-
pressed gases, or liquefied gases. The emission rate of the material to the 
atmosphere is largely dependent on the shipment state. Due to their low 
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volatility, solids typically exhibit slow release rates. Consequently, with few 
exceptions, non-water reactive materials treated with CASRAM are liquids 
and gases at atmospheric pressure. These shipment states are illustrated in 
Figure 2, and are discussed below. 

 
Figure 2. The three source types of importance for inhalation risk: (a) ordinary liquids, 

 (b) compressed gases, and (c) liquefied gases. 

Liquid materials are emitted to the atmosphere through pool evaporation 
as illustrated in Part (a) of Figure 2. The pool evaporation rate is depen-
dent on many factors. For volatile liquids, the governing factors in deter-
mining the release rate, in approximate order of their importance, include: 
(1) vapor pressure of the liquid, (2) available energy, (3) pool size, (4) wind 
speed, and (5) atmospheric stability. In the case of low-volatility liquids 
(i.e., those characterized by low vapor pressure), meteorology replaces 
available energy in relative importance. Highly volatile liquids can evapo-
rate very quickly (within minutes), cooling the pool in excess of 30°C be-
low the ambient temperature. In such cases, the evaporating material can 
actually freeze, thus substantially reducing the evaporation rate.  

Compressed gases are released in a so-called “blowdown” process, as illu-
strated in Part (b) of Figure 2. The blowdown process usually empties the 
container rapidly, and, in the case of severe accidents, may result in a 
nearly instantaneous release. All else being equal, release rates for com-
pressed gases are many times higher than for ordinary liquids. The excep-
tion to this rule is minor valve failures, for which release rates may be very 
small.  

The most catastrophic form of release involves liquefied gases, as is illu-
strated in Part (c) of Figure 2. Here, the release is broken into two phases. 
In the initial phase, denoted as the flashing and entrainment phase, a rela-
tively small quantity of the material (usually 0-30% of the total) is instan-
taneously vaporized upon exiting the vessel, due to the sudden reduction 
of pressure. With rapid expansion of the material, the vapor typically en-
trains substantial quantities of the remaining liquid, forming an aerosol. 
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This aerosol usually evaporates quickly when exposed to air, cooling the 
vapor/air mixture to the point where the density of the mixture is often 
considerably heavier than air. Any liquid remaining after this process is 
deposited on the ground or surrounding surfaces, and is released through 
evaporation. Since the vapor pressures for such materials are usually well 
above atmospheric pressure, the evaporation phase is typically short, es-
pecially in comparison to the pool evaporation phase for materials that are 
liquids at atmospheric pressure. Due to the large quantity of material often 
involved, liquefied gas releases yield the largest release rates in compari-
son to liquefied and compressed gas releases.  

The source component of CASRAM determines hazardous material release 
rates for each of the spill and/or vaporization scenarios described above. 
Pool evaporation within CASRAM is determined using a time-dependent 
energy-budget model that accounts for the key air-pool-ground energy 
fluxes that govern the evaporation rate. Heat transfer to and from the pool 
is treated via explicit consideration of solar radiation, air convection, 
ground conduction, and evaporative heat loss from the pool. The necessary 
transfer coefficients for evaporation are provided by a chemical property 
database, a preprocessed meteorological database, and output from 
SEBMET. Compressed gas releases are treated using semi-empirical blow-
down relationships based on compressible-flow theory. Liquefied gas re-
leases are treated by first calculating the flash fraction of the exiting ma-
terial, and then determining the fraction of the remaining liquid that is 
entrained into the flashed vapor. This entrainment fraction is calculated 
using empirical relationships based on the discharge kinetic energy of the 
two-phase mixture. Released material that does not flash to vapor (and, 
that is not entrained in the vapor cloud) is assumed to deposit on the 
ground. Release of this deposited material is handled using the evapora-
tion model. 

As an aid in characterizing release scenarios and estimating release rates, 
the source model in CASRAM utilizes a database of the physical properties 
for over 300 toxic chemical compounds. For some material parameters, 
estimation of properties are used, due to the unavailability of experimental 
data in the literature. For transportation accidents, the current version of 
CASRAM contains statistical, empirically-based discharge fractions de-
pendent upon container type and size, and transportation phase, that were 
developed using data contained in the Hazardous Materials Incident Re-
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porting System (HMIS) maintained by the U.S. Department of Transporta-
tion. For fixed facility analyses, release parameters are entered by the user. 

2.2.2 Environmental data 

HPAC has a sophisticated module for input of the meteorological data 
needed to calculate accurately the dispersion of the agents. It can default 
to use historical weather data for the location, or ingest archive or gridded 
forecast data from DTRA's Meteorological Data Server (MDS). The 
CBRSim tool simplifies the necessity to apply for a DTRA MDS account or 
to look for alternate sources of meteorological data, by allowing the user to 
input a single surface observation consisting of temperature, wind 
speed/direction, relative humidity, cloud cover and cloud height. 

The CASRAM model comes with a meteorological preprocessor model 
called SEBMET. This model takes a single meteorological observation, as 
input by the user, and calculates the needed meteorological parameters for 
use in the SCIPUFF dispersion model (discussed in Section 2.2.3). It has 
land cover/canopy data and climate data for the United States that it uses 
in its detailed calculations. The model takes the observation input and 
creates the meteorological parameters (every 15 minutes) for the duration 
of the HPAC modeling run. This output data is read in by SCIPUFF, which 
produces its output at 15-minute intervals for display. The following sec-
tion describes the physical processing employed within the ANL-
developed SEBMET model. 

2.2.2.1 The SEBMET meteorological preprocessor 

SEBMET contains two primary components: a surface energy budget 
(SEB) model that determines the surface-layer turbulence parameters, and 
an integral model that determines inversion height in convective condi-
tions. Each component is briefly outlined below. For additional informa-
tion on the meteorological preprocessor, including details on its develop-
ment and validation, see Brown (1997).  

2.2.2.2 Surface turbulence parameters  

The surface-layer parameters are determined by using a SEB model that 
consists of parameterizations of the various SEB components and flux-
profile relationships (equations that relate wind speed to friction velocity 
u* and sensible heat flux). The goal of this modeling approach is to isolate 
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the sensible heat flux H from the other energy budget components. The 
starting point for this analysis is the SEB at the ground. When advection, 
photosynthesis, and snow melt are neglected, the SEB is most simply 
represented as follows:  

 Q* = H + λEw + G + Qa  

where: 

 Q* = net surface radiative heat flux,  
 G = conductive soil heat flux,  
 λ = heat of vaporization for water,  
 E = evaporation rate (together, λEw is the latent heat flux), and  
 Qa = anthropogenic heat flux.  

The net surface radiative heat flux is the residual from the absorbed solar 
radiation S, incoming long-wave radiation L+, and outgoing long-wave 
radiation εσTs

4 . It is written as follows:  

 4+*   +   +  )1( = sss TLSQ σεα−  

where: 

 αs = surface albedo,  
 εs = surface emissivity,  

 σ = Boltzmann constant, and  
 Ts = surface temperature.  

At the surface, the short-wave balance is always positive, while the out-
going long-wave radiation generally exceeds incoming long-wave radia-
tion. The model is constructed by parameterizing each of the components 
in the SEB in terms of routinely observed meteorological observations and 
site characteristics. A brief description of the SEB component parameteri-
zations is presented below.  

2.2.2.3 Inversion height and boundary layer height 

The inversion height in convective condition is estimated with a one-
dimensional model of the atmospheric boundary layer based on the Drie-
donks slab model (Driedonks 1982). In the Driedonks model, as in similar 
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models, the surface turbulence fluxes, u* and H, are integrated over time 
so that the boundary layer evolves from an initial early morning height. 
The Driedonks model was chosen because of its comprehensive treatment 
of dynamics at the inversion, favorable comparison with field data, and 
ease of inclusion in the preprocessor.  

In neutral and stable conditions, the boundary layer height is less well de-
fined. Generally, the boundary layer height, at least in stable conditions, is 
taken to be the height at which surface-induced turbulence drops to a neg-
ligible value. Here, the diagnostic relations for stable conditions are used, 
defined by Nieuwstadt (1981), and provided by the neutral limit (h = 
0.3u*/f, where f is the Coriolis force), following the recommendations of 
Hanna and Paine (1989). (Hanna and Paine recommend that the neutral 
relation be used when L is greater than or equal to 100, and that Nieuws-
tadt’s relation be used when L is more than zero but less than 100.) 

2.2.3 Air dispersion models and health effects plots 

2.2.3.1 Atmospheric transport model 

HPAC includes an atmospheric dispersion model called SCIPUFF. The 
SCIPUFF model was written by, and is maintained by, Titan Corporation. 
This Fortran model represents the released agent as a series of Gaussian 
puffs in order to represent a 3-dimensional, time-dependent agent concen-
tration field. It calculates the complex diffusion flow of the dispersing 
agent, taking into account effects from terrain topography, planetary 
boundary layer turbulence, and wind shear at multiple layers in the at-
mosphere. (See the SCIPUFF Technical Manual [Sykes, 1998] or the HPAC 
User's Guide [DTRA, 2002] for an in-depth discussion of the physics of 
these models.) The output from the SCIPUFF model is contoured, using 
threshold values for adverse human health effects, and is available for dis-
play on the CBRSIM JeoViewer map at each 15-minute interval of simula-
tion time. 

2.2.3.2 Leaky Box Model 

During an outdoor release of a CBR agent, a building’s indoor contamina-
tion levels are dependant on: the building outdoor air change rates and the 
contamination levels of that outside air. To model this dependency, the 
CBRSim system uses another ANL-developed model. This “Leaky Box” 
Model incorporates physical processes to calculate indoor air concentra-
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tions from an overhead plume, and models the effects during an incident 
from turning building HVAC systems on and off, and, from closing and 
opening windows/doors . 

The building air change rate is a measure of the rate at which outdoor air 
enters the building. The air change rate of a particular building at a given 
time is a function of building layout, HVAC system design and operation, 
the operation of other building systems such as exhaust fans and vented 
combustion equipment, building envelope airtightness, and exterior 
weather conditions. A key simplification in this framework is that the 
building is represented as a single well-mixed box, meaning that the air 
within the building maintains a spatially uniform concentration. 

Contaminant concentrations within buildings are calculated based on the 
time history of the outdoor concentration and the building air change 
rates. For each building, the indoor concentration is modeled, using the 
following equation: 

 

 

Cin (t) = Cout (τ)Ac exp(−Ac (t − τ ))dτ
0

t

∫   

where: 
 Cout and Cin = outdoor and indoor concentrations, respectively,  
 t = time, and  
 Ac = building ventilation rate 

For constant Cout from 0 to T, the relationship for Cin reduces to the simple 
relations for one of the following equations: 

 when 0 > t > T: 

 

Cin(t) = Cout 1− exp −Ac t[ ]( )  

 when t > T: 

 

Cin(t) = Cin(T)exp −Ac (t − T)[ ]  

For many buildings, this is a reasonable assumption. However, as the 
building size and the number of rooms (and HVAC zones) increases, this 
assumption becomes less valid. Another assumption is that there are no 
chemical removal mechanisms such as chemical reactions and gas adsorp-
tion within the building besides the air change rate with the outside. How-
ever, such mechanisms would reduce the chemical concentrations in 
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buildings, making the assumption to neglect these effects a conservative 
one.  

The building air change rate is generally expressed in terms of air changes 
per hour (h-1). For the leaky box model, the total building air change rate is 
taken as the sum of the outdoor air intake through the HVAC system and 
the rate at which outdoor air enters the building through infiltration.  

For each building represented in the model, three air exchange rates can 
be set. These rates are referred to in the following section, as follows: 

(A) HVAC air change rate, in normal mode of operation, 
(B) Building envelope leakage rate, with doors and windows closed 
(C) Building envelope air change rate, with doors and windows 
open. 

2.2.4 Installation shelter-in-place protection strategy model 

Shelter-in-place can be an effective protection strategy against CBR at-
tacks. In an emergency, building air change rates can usually be reduced 
substantially by deactivating the ventilation system and closing windows 
and doors. CBRSim simulations employ a shelter-in-place scenario.  

During model operation, we assumed building ventilation progresses 
through four stages for each building.  

• Stage 1 (Normal Mode) is at the beginning of a simulation, before con-
tamination reaches the building. The building HVAC system is as-
sumed to be running at normal mode, with the windows and doors 
closed. (Building air change rate = A + B).  

• Stage 2 (Shelter-in-Place Mode) is invoked once the contaminant 
plume reaches the building. The building HVAC system is turned off, 
and the doors/windows remain closed. (Building air change rate = B). 
During this stage, the building is flagged as contaminated, and the 
model will continue calculating the indoor/outdoor air change rate 
(every 15 minutes with HPAC outdoor concentration predictions), until 
the building’s outside air contamination level reaches below minimum 
health levels as determined by HPAC.  

• Stage 3 (All-Clear Mode) is then invoked, and the building HVAC is 
turned on with the doors and windows remaining closed. (Building air 
change rate = A + B).  
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• Stage 4 (Flushing Mode) occurs after an hour at which exterior conta-
minant concentrations remain acceptable. The HVAC remains on, and 
the windows and doors are opened (Building air change rate = A + C).  

If another plume comes overhead, the whole process starts over.  

2.3 Output 

For an introduction to the CBRSim GUI, see the draft User’s Manual (Ap-
pendix A). 

Figure 3 shows the results of a simulation in-progress. It is paused to take 
a snapshot (as shown in the simulation control panel, bottom right). The 
JeoViewer is displaying the plume contours (Surface Dosage for Sarin as 
selected within the Display Control panel), the Thematic Legend is show-
ing the plume contour values for Surface Dosage as well as the indoor air 
concentration calculated in the leaky box model by using the plume con-
centration values overhead of the building. 

 
Figure 3. Simulation output shown on JeoViewer map with thematic legend, 

display control window, and simulation control panel. 

The three types of HPAC-produced plots that are created for the CBRSim 
model are: (1) the concentration in air, (2) the surface deposition (on the 
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ground), and (3) the surface dosage (integrated air concentration over 
time). The contour values shown in the Thematic Legend are co-
lored/labeled with toxicity/health exposure thresholds, as typically used in 
emergency response scenarios. Different sets of thresholds are used for 
different agents. These thresholds include Acute Exposure Guideline Le-
vels (AEGLs), Emergency Response Planning Guidelines (ERPGs), Imme-
diately Dangerous to Life or Health (IDLH) levels and Temporary Emer-
gency Exposure Limits (TEELs). These threshold criteria define 
concentration levels that are toxic to humans at three levels of severity. For 
many chemical and biological agents, exposure to a vapor or aerosol is 
measured from the surface dosage, and then quantified in a Concentration 
Time (Ct) category. The Thematic Legend labels may include LCt values 
(lethal dosage of exposed, unprotected personnel (e.g. LCt-50 is lethal to 
50% of the personnel)) and ECt and ICt values (Effective and Infective do-
sage of exposed, unprotected personnel for biological agents and the Inca-
pacitating dosage for chemical agents). For Surface Dosage (calculating 
the amount of mass deposited on the surface), the contour labels are 
shown as LD (as in LD-90 is the amount of liquid agent expected to kill 
90% of the personnel). 

For a detailed explanation of the HPAC-produced plots, refer to the HPAC 
User’s Manual, (specifically the sections on Biological Agent Toxicity, NBC 
Human Health Effects and Related Plots, and Toxicity Level Contour Defi-
nitions). 

The Query tool, shown in Figure 4, lets the user select items on the map 
and look at their attributes.  
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Figure 4. Point query, showing table of attributes. 

Most of the attributes are from the ESRI shapefile/dbf file loaded in for 
the installation’s facilities. Some of the attributes are created while the si-
mulation executes. Notice the GB:concentration values (Sarin) for the 2 
buildings selected (FFID-122 and FFID-196). Also, the HVACState, HVA-
CAirExchange, closedAirExchange, and doorAndWindowState are all filled 
in while the leaky box model is running. 
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While the simulation is executing, the user can monitor certain buildings 
and switch between views of the types of plots. By using the Recording 
tool, one can make several runs of the same agent or different agents, and 
use the saved movies to compare/contrast the incidents. 

2.4 Potential system users 

Potential users of the CBRSim system are force protection officers, emer-
gency response teams, and master planners. Unlike HPAC and other 
plume model software, CBRSim provides visualization changes in conta-
minant concentration within buildings, based on changing the building 
ventilation characteristics.  

Force protection officers can use simulations to instruct building occu-
pants on the benefits of shelter-in-place, and also get buy-in from manag-
ers on understanding and executing protocol in event of an external CBR 
release incident.  

The system can also be used as a planning tool for emergency response 
planners (such as a Fire Chief). Master planners can run simulations of 
high-risk release scenarios, and make decisions on placement of facilities. 
As an example, if a toxic chemical were transported by rail at a high fre-
quency, it may be undesirable to place high-risk targets (HRTs) or a mis-
sion essential vulnerable area (MEVA) in the vicinity or on the downwind 
side of prevailing air currents. 

2.5 System implementation 

Implementation of CBRSim at a site, such as a military installation, re-
quires collection of Geographic Information System (GIS) data, establish-
ing building air leakage parameters for buildings of interest, and develop-
ment of the installation model. 

2.5.1 GIS data collection 

Applying CBRSim to installations or sites that do not yet have GIS data re-
quires only minimal data collection. If an installation has GIS data for its 
facilities, then the bare minimum data is already available to implement 
the model and application. If an installation lacks GIS data for facilities, 
the necessary data can be rapidly created using standard GIS tools and 
available maps, or aerial photography.  
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CBRSim was designed to be installation-independent, meaning that it can 
readily be configured for any installation by providing a few necessary 
ESRI shapefiles.  

Only two GIS datasets are needed for development of the model: 

• Road network (centerlines of primary and secondary roads) 
• Building footprints facilities to be included in the model (with or with-

out HVAC parameters specified) 

Adding additional facility attributes provides greater analytic capability, 
but are not necessary for running the model. 

As part of installing the CBRSim software, a “Fort Readiness” template is 
placed in the program directory. This template is used as a starting point 
to generate the installation model. By copying the directory structure for 
Fort Readiness, and replacing the above shapefiles with files of the same 
spatial projection, the CBRSim can be “relocated” to the particular instal-
lation being modeled. Section2.5.3 provides details about setting up a new 
installation, and Appendix A provides detailed descriptions of the files in-
volved. 

2.5.2 Building air change rate data 

As mentioned previously, three building air change rates (A, B, and C) are 
used to determine the building contamination concentration at different 
stages during a simulation. These values can be put into a model in two 
different ways. Default values have been preloaded into the shapefiles and 
apply to all buildings. These default values (in air changes per hour) are: A 
= 2, B = 0.5, and C = 2. However, if better estimates are preferred for par-
ticular buildings of interest, the user can also specify different values for 
those, and enter them in their respective shapefiles.  

For this purpose, a 12 tables have been included in Appendix B to provide 
air leakage estimates for different classes of buildings (single-family 
homes, schools, barracks, warehouses, etc.), for different relative levels of 
building airtightness, and for severity of weather. These tables were devel-
oped based on American Society of Heating, Refrigerating and Air-
Conditioning Engineers (ASHRAE) Standard 62.1, a limited amount of 
collected data, and engineering judgment derived from energy and build-
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ing air leakage investigations conducted by the National Institute of Stan-
dards and Technology (NIST). 

2.5.3 Model development 

To model a new installation requires geospatial data be placed in specific 
locations with specific formats. (See the CBRSim Directory and File Struc-
ture section in Appendix A for a description of the overall files used in the 
system.)  

To change the Fort Readiness version to represent a specific installation 
requires replacing files created during program setup with installation-
specific data (see Appendix A).  

There are two ways to accomplish this:  

1. This is most simply done by converting file formats and renaming in-
stallation data, consistent with the existing data types and names. This 
entails possibly re-projecting geospatial data and may result in a less 
accurate geographic representation. For most installations using the 
model for planning, however, the impact of this additional inaccuracy 
would be negligible. The expected projection is UTM Zone 13, GRS 80, 
units expressed in feet. 

2. The other option will result in a model with more geospatial accuracy, 
but requires editing model-related text files. This requires changing the 
projection specification files to reflect the projection used in the instal-
lation data. To change the projection specification requires editing text 
files (readiness.dat, readiness_centerlines.dat, and readi-
ness_facilities.dat). The parameter within each file, Projected Projec-
tion, may be edited to specify a different UTM Zone.  

The installation files are under the GeoData directory.  

The readiness_centerlines.dat file is the file used when loading the road 
network. The expected projection is UTM zone 13, units in feet and con-
sists of polylines representing the center lines of the installation’s road 
network. The NameField of ROAD_NAME is the column header (in the 
corresponding dbf file) used to identify the road segments. Be sure it 
matches the name in your dbf file. In the case of Fort Readiness, primary 
and secondary roads are loaded. The expected filenames are: 
trveh_road_primary_centerlines.shp and 
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trveh_road_secondary_centerlines.shp, respectively. Copy your road net-
work files to the network directory. 

The readiness_facilities.dat file describes the facility footprint shapefile. 

Projection is assumed at UTM zone 13, units in feet. The NameField here 
is important in that it must correspond to the column header of the unique 
identification (ID) for the buildings in your file. Facilities without unique 
IDs or duplicate IDs will not interact with the plume model. You may no-
tice this when running the model as buildings that do not change color on 
the JeoViewer map when a plume is overhead. FACIL_ID is the column 
header that contains the data for expected unique IDs. The unique ID 
“NR” is reserved, and any facilities assigned this ID will be skipped by the 
model. The expected filename is: bggen_structures.shp. Copy your facility 
shapefiles to the facilities directory.  

Facility data may be assigned air change rate values. If these values are 
missing or the fields are not provided, default values are used. If the fields 
are provided and zeroes are specified, the zero values will be used. To use 
the defaults, ensure that the fields are not provided, or put the defaults in-
to the fields. Air change rates may be specified for the HVAC system (A), 
building envelope leakage with open windows and doors (C), and building 
envelope leakage with closed windows and doors. The expected field 
names are: 

• Unique ID: “FACIL_ID” 
• HVAC air change rate: “EXCH_HVAC” 
• Open windows and doors air change rate: “EXCH_OPEN” 
• Closed windows and doors air change rate: “EXCH_CLOSE” 

The LayerDefinition in layer_defs/Background.def is used to render the 
shapefiles and other data shown on the map. There is no mandatory edit-
ing required for the Background.def file. 



ERDC/CERL TR-09-39 21 

 

3 CBRSim Demonstration at Fort Carson 

3.1 Model development 

ERDC-CERL developed a Fort Carson model for the CBRSim computer 
program using installation-specific data. To accomplish this, the research 
team met with utility to installation force protection officers, emergency 
responders, and DPW personnel to provide a briefing on the tool and its 
capabilities. Installation geospatial data, in CAD format, were obtained for 
select buildings, roads, and topographic features in order to locally cali-
brate the model, and 10 buildings were selected as the focus of the Fort 
Carson simulation. The ERDC-CERL team performed visual inspections of 
the selected buildings, and Fort Carson personnel collected data for esti-
mating air exchange rates. 

Upon receipt of the localization data, the Fort Carson CBRSim model was 
developed largely following the steps described in section 2.5.3. To provide 
additional geospatial context, topographic data was included in the visual 
display. The topographical information, which were furnished at high 
resolution with point, line, and polygon data, was processed from .DGN 
CAD files into ESRI shapefiles for contour lines at five-foot intervals. All 
data were projected to UTM Zone 13, with the units expressed in feet. 

The building data were further modified to include air exchange values. 
Appendix B describes how default air change values were developed. For 
10 selected Fort Carson buildings, air change values were established using 
the methodology provided in Appendix B, and the shapefile data table was 
accordingly customized. The remainder of the Fort Carson buildings were 
specified with the default values (air changes per hour of A = 2, B = 0.5 
and C = 2) as discussed in section 2.2.3.2 (HVAC air change in normal 
mode of operation (A), building envelope air change rate with doors and 
windows closed (B), and building envelope air change rate with doors and 
windows open (C). 

Following this data processing, the files were copied into the appropriate 
directories for the CBRSim application, resulting in a CBRSim model spe-
cifically customized to Fort Carson. While an installer was created to hand 
this model to Fort Carson, the installer developed for Fort Readiness and 
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the data manipulation detailed in section 2.5.3 is sufficient to customize 
CBRSim to another installation. 

3.2 Workshop 

3.2.1 Attendees 

As part of this project, ERDC-CERL researchers visited the Force Protec-
tion Office at Fort Carson to lead a workshop using the CBRSim tool confi-
gured with the Fort Carson model. The purpose was to solicit input from 
prospective users about the software design, uses, and capabilities. Attend-
ing was the Fort Carson CBRNE Operations Specialist, who was given a 
briefing on the functions and use of the tool. CBRSim was installed on a 
non-networked laptop computer and simulations were run under varying 
scenarios and parameters. Due to installation security requirements, nei-
ther that data nor its representations are provided in this documentation. 
The CBRNE Operations Specialist provided user feedback and collabo-
rated with the team about lessons learned. The ERDC-CERL team then 
provided an outbrief to the Chief of Plans and Operations, the Plans and 
Exercise Supervisor, and the Senior CBRNE Operations Specialist.  

3.2.2 Lessons learned 

The following lessons were learned from the Fort Carson CBRSim demon-
stration: 

• Time-stepped visualization is very useful for demonstration to other 
groups, such as emergency responders and facility managers. This may 
facilitate appropriate planning and response. 

• Time-stepped visualization should allow the user to pause, step for-
ward and back at appropriate time increments to easily see where a 
contaminant plume was, is, and where it is going. 

• Selection of hazard parameters (material type, quantity, containers, 
etc.) should be automated (if connected to sensors), or should be sim-
plified (provide icons and easy access to instructions), particularly if 
the tool may be used by emergency responders. In emergency re-
sponse, inputs should parallel data likely to be available in an emer-
gency. 

• Visual displays should offer the ability to show building numbers and 
road names and other significant information that helps to orient the 
user. 
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• Visual displays should allow the user the ability to modify what is dis-
played, to include turning certain information on/off, such as geospa-
tial data or contaminant information. 

• Installation-oriented threats, such as improvised explosive devices 
(IEDs) and backpack bombs, must be included in the modeling capa-
bility. 

• Measurement unit specification should be flexible based on user-
requirements (for example, do not require the user to convert to or 
from metric). 

• Weather parameter specification should be automated or simplified to 
allow easy user access to specifying defaults for a given simulation.  

• Software installation and local configuration instructions should be 
reasonably simple and clear, requiring minimal technical support. 

• Software displays should be presented logically, based on intended use 
(e.g., emergency response or planning) of the model by default. 

• Visual representation of exposure to contaminants should be easy to 
interpret, and a “click-on” or “roll-over” textual interpretation of the 
visual representation should be provided to help explain, for example, 
the lethality or contagion of an exposure indicated for a “red” coded fa-
cility. 
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4 Conclusions and Recommendations 

4.1 Conclusions 

As part of this demonstration, a methodology based on “rules of thumb” 
was developed to help provide building air change rates with outdoor air 
for use with the CBRSim “leaky box” simulation model. This methodology 
was intended to make it possible to customize model parameters in order 
to simulate the results of CBR attacks on specific buildings. A draft user’s 
manual was also developed. 

At this stage in its development, the CBRSim software tool is not ready for 
validation with respect to building air exchange. Therefore, use of the tool 
should be confined to educational, training, and software development ac-
tivities, and it should not be considered to be reliable or field-ready. 

However, because of its ease of use, minimum data requirements, and ver-
satility in providing a visual display of both indoor and outdoor contami-
nation levels, it can be useful in installation planning, and in training both 
building managers and emergency response teams. 

4.2 Recommendations 

The alpha version of CBRSim documented here should not be considered 
field-usable for a reliable, detailed simulation of the effects of a CBR attack 
on real-world facilities. In particular, CBRSim should not be used for vul-
nerability assessment, or for decision-making or response to an actual in-
cident until the simulation model and software is validated in terms of air 
exchange and transfer of contamination between the building interior and 
surrounding outside air. 

However, because the alpha version of CBRSim is easy to use, has minimal 
data requirements, and provides a versatile display capability for illustrat-
ing both indoor and outdoor contamination levels, it could be useful both 
for incident planning and for training building managers and emergency 
response teams. For example, CBRSim could be used in conjunction with 
training exercises for emergency responders such as hazardous materials 
teams, paramedics, firefighters, and law enforcement personnel to provide 
insights into how to deal with alternate hypothetical incidents. Simulation 
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results could be used to help evaluate the speed and effectiveness of first 
responder protocols and activities. It could also be used as an educational 
tool by the installation Force Protection Officer and others when training 
facility personnel, supervisors, etc., on the importance of shelter-in-place 
measures and having established incident protocols. The Officer also could 
make building visits and run simulations for any personnel responsible for 
the safety of building occupants (administrators, teachers, etc.) to illu-
strate the benefits of shelter-in-place procedures. 

It is recommended that modifications to the user interface be considered 
in response to feedback received from users and other input from re-
searchers. 

It is recommended that CBRSim be considered for technology transition to 
an appropriate advanced development program such as the Installation 
Protection Program under the Joint Program Manager Guardian. Further 
development should include systematic validation studies to address the 
alpha version’s current insufficiencies for use in actual planning and re-
sponse activities. 
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Quick start guide 

1. You must first have the following installed on your system; these are 
not provided on the CBRSim Installation CD: 
 Hazard Prediction and Assessment Capability (HPAC) 4.0.3 update  
 HPAC Interface for Consequence Effects (ICE) HPAC requires a li-

cense from the Defense Threat Reduction Agency (DTRA) 
http://www.dtra.mil/rd/programs/acec/index.cfm. ICE is an ob-
ject-oriented interface to HPAC, written by Science Applications 
International Corporation (SAIC) for DTRA. 

2. Insert the CBRSim Installation CD or open the .zip file. Execute 
FFVI_Readiness.exe

3. Installation will prompt you to replace HPAC material files (a backup 
will be made). For full functionality of CBRSim, replace the files. 

 to install the CBRSim application. You must 
have administrator rights to install CBRSim. 

4. Choose the installation directory and complete the installation. 
5. Double-click the Fort Future Readiness Model

6. Click the arrow button (icon) on the map to cause the map to re-center 
on your click. Right-click on the map to select other zoom options. Use 
the magnifying glass icon to zoom in on an area. Use the query tools 
icons to open attributes about individual or multiple map features.  

 icon on your desk-
top or navigate Start>All Programs>FFVI>FFVI_Readiness>Fort Fu-
ture Readiness Model. All necessary components of CBRSim will open. 
To properly run CBRSim, you must have read/write permissions for 
the HPAC and CBRSim folders. 

7. Choose a CBR Icon and click anywhere on the map. Input parameters 
for the CBR incident. Choose the sun icon, and click on the existing 
meteorology input, or insert another, then choose the weather parame-
ters. 

8. Select View>Show Thematic Legend and then Tools>Display 
Control

9. Select 
. 

Run>Run Model

10. See the complete documentation for additional details. 

, wait, and observe the plume and its interac-
tions with the facilities. You may continue using the map, though inte-
raction with the map may be slow. 
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System installation 

The CBRSim Installation CD contains the installer for the Chemi-
cal/Biological/Radiological Simulation System (referred to as CBRSim). 
However, before installing the CBRSim software, please make sure the fol-
lowing software packages have been installed: 

• Hazard Prediction and Assessment Capability (HPAC) 4.0.3 update  
• HPAC Interface for Consequence Effects (ICE)  

HPAC requires a license from the Defense Threat Reduction Agency 
(DTRA) http://www.dtra.mil/rd/programs/acec/index.cfm. ICE is an ob-
ject-oriented interface to HPAC written by Science Applications Interna-
tional Corporation (SAIC) for DTRA.  

After the HPAC4 has been installed with 4.0.3 update, run the install.exe 
executable to install CBRSim on your machine. The installer will ask for 
the location of the HPAC4 installation directory as it needs to reference 
files there. An installer is provided for a fictional Fort Readiness, which 
may be adapted to a real installation. You will be asked where you would 
like to install FFVI (root directory referred to as FFVIroot). The default for 
the FFVIroot directory is C:\Program Files\FFVI_Readiness.  

The installer will prompt the user to replace the HPAC material files; this 
is recommended. The CBRSim system required additional agents and cor-
rected others within the original HPAC installation. The original material 
files will be zipped up before the edited ones are copied to the HPAC in-
stallation\server\data\materials directory. If you choose not to install the 
edited material files, parts of the CBRSim may not work properly. 

The installation script will put a DOS batch file fortfuture.bat file installed 
in the FFVIroot directory. A shortcut icon is placed on the desktop, labeled 
Fort Future Readiness Model as well as put into the Start Menu. Double-
clicking on this icon will launch CBRSim along with the HPAC and ICE 
servers (those processes have no GUI and run in the background, the only 
visible sign is associated DOS windows with log messages for these 
processes). 



ERDC/CERL TR-09-39 30 

 

CBRSim user interface 

Main window 

When the CBRSim starts, installation data and the software for selected 
modules will be loaded. Once the installation data and software for se-
lected modules are loaded, the main CBRSim window will appear (Figure 
A1). The CBRSim main window will default to display the entire installa-
tion database. At the top of the main window there are menu items (File, 
Edit, View, Run and Tools) and a collection of icons used to select a mode 
(a particular CBRSim function). At the bottom of the main window, infor-
mation about the 1) geographic location of the curser, 2) resolution of the 
current geographic view, and 3) status of the selected mode are displayed. 
This main window is based on the Argonne National Lab-developed Object 
Oriented GIS spatial visualization tool called JeoViewer. Since the 
CBRSim client (main window) is a separate process from the ICE/HPAC 
and they communicate via CORBA (see Figure 1 CBRSim Processes), 4 
DOS windows appear along with the main window. These DOS windows 
should not be closed, but may be minimized to the task bar. The DOS win-
dow processes are: 

tnameserv.exe – The is the CORBA naming service (like a yellow page list-
ing) where the processes that need to communicate look up each other’s 
“address” in order to connect and call methods between themselves. It 
should indicate that the port is set to 1400 and Ready. 

ICE.bat – This is the window associated with executing ICE. This bat script 
also starts the HPAC services. Log messages are written to this window 
from the various HPAC services (e.g. CBWeapon, Scipuff). 

java.exe – a DOS window associated with another service from HPAC (it 
ends with Listening on port: 1099). 

HPAC Model Controller – This is the window associated with the HPAC 
Model Controller process which communicates via RMI with the CBRSim 
client and via CORBA with the ICE process. When the system if first 
started, it should say the it is waiting for connections. While the simulation 
is executing, it will show log messages on the status of the run. 
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Fort Future Client – lastly, the DOS window associated with the CBRSim 
main window pops up. The window is used for logging messages from the 
client Java process. 

 
Figure A1. CBRSim main window, showing Fort Readiness. 

Menu items 

Across the top of the Main Window, there are five drop-down menus: File, 
Edit, View, Run , and Tools. 

File menu 

The file menu contains two options: 

• About: Displays information on the CBRSim software 
• Quit: Exits the CBRSim software 
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Edit menu 

The edit menu contains one option at this time: 

• Close Charts: Closes activity charting windows (which will only be set 
when running a the installation process model within the simulation). 

View menu 

The view menu contains five options: 

• Zoom Out: Rescales the display by zooming out. 
• Zoom Scaled: Contains a submenu where the user can choose to res-

cales the geographic display by zooming in or out by 2,5,10,or 100 
times the current display scale  

• Zoom Entire DB: This resets the geographic display back to the entire 
installation database. 

• Redraw Map: Redraws the geographic display using current settings. 
• Show Thematic Legend: Displays a thematic legend for spatial results 

from CBRSim simulations. The legend is automatically generated from 
the data being displayed (e.g. plume concentrations, building (facility) 
contamination status). 

Run menu 

Run Snapshot Recorder: Brings up the CamStudio application for record-
ing the simulation. CamStudio is an open source screen capture utility in-
cluded with the CBRSim. Its intent is to record a simulation for future 
playback and comparison to subsequent simulations with varying runtime 
parameters. Figure A2 shows the main window of CamStudio after select-
ing the Snapshot Recorder in the Run Menu. 
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Figure A2. CamStudio main window. 

Within the CamStudio application, the first thing to do is to set the Frames 
per Second (fps) for recording the video. The default is 20 fps, but this is 
too frequent for recording these types of simulations and therefore should 
be set to a smaller fps to reduce file size of the movie file. Do this by select-
ing Options->Video Options. To get 4 frame per second, for example, slide 
the Time Lapse bar to the right at stop when the Capture Frames Every 
15000 milliseconds shows (see Figure A3). Refer to the CamStudio Help 
manual for further explanations of video settings. 
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Figure A3. Video options window for CamStudio. 

The second thing to do is to set the recording region. Select menu Region-
>Region. This will prompt you to define the rectangular region before re-
cording starts. Use the rubberband box to outline the area on the comput-
er display that you want to record during the simulation. The cursor turns 
into a pen with cross-hairs to define the region. 

You may choose to record the full screen if you would like to show the oth-
er windows during playback (such as the Display Control and Simulation 
Control windows). Otherwise, be sure to Select the View->Show Thematic 
Legend on the main CBRSim window so that the legend is captured along 
with the geospatial map. 

When you are ready to record (after you have set up your scenario, defined 
releases, and brought up the Simulation Control window (via Run Model 
[see below] and the Display Control window), press the Record Button on 
the CamStudio window. At this point, if you set the Region to record to re-
gion, it will change the cursor to the cross-hairs for outlining the window 
area. If you chose full screen, it will start recording. 
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Start the simulation executing by selecting Run->Run Model from the 
CBRSim main window. 

Run Model: Runs a simulation based upon parameters the user has input 
into one or more of the CBR incident models. Figure A4 shows the Simula-
tion Control window that comes up for controlling the execution. 

 
Figure A4. The simulation control window. 

The simulation will call the CASRAM/HPAC models every 15 simulation 
minutes and will produce plots that will update on the screen.  

If you are recording the simulation, you may zoom in/out and change 
which plume to view while it is capturing the screen. The CamStudio will 
need to be stopped after the simulation is done (or if you no longer want to 
record due to the plume being out of the area of interest). To do this, press 
the Stop button on the main CamStudio window. It will prompt for a file 
name and location to save the .avi movie file to. The CamStudio Player 
window also comes up after you’ve saved a recording.  

Once an .avi file is saved, you can start CamStudio externally by finding 
Player.exe in the CamStudio directory of your CBRSim installation. Open 
the saved .avi file from the File Menu and control playback like a video re-
corder.  

Lastly, you will need to exit the Recorder and/or Player separately from 
exiting the CBRSim main window, since it is a separate application. 
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Tools menu 

 Layer Manager: The JeoViewer Layer Manager is rather cryptic 
and comes with CBRSim as part of using JeoViewer for the spatial 
display. Figure A5 shows a snapshot before the simulation is ex-
ecuted. It is a control panel for turning on and off layers in the main 
map view. The much simpler Display Control window was created 
for CBRSim use, so the more complicated Layer Manager is not re-
ally needed. 

 
Figure A5. JeoViewer Layer Manager window before simulation execution. 
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 Display Projection: The Display Projection option is used to 
change the projection used to draw the map. To change the map 
projection being used for display, select from the list of available 
display map projections (XY, Polar Stereographic, Lambert Con-
formal Conic, Mercator, and Transverse Mercator). Depending on 
which projection the user chooses, other information will be re-
quired (e.g. zone, ellipsoid name). Figure A6 shows the Display Pro-
jection Window. 

 
Figure A6. Display Projection window showing the projection parameters for  

the Fort Readiness shapefile data. 

 Display Control: The Display Control window is used to control 
the layers that are displayed on the JeoViewer (Figure A7). It is 
handy to turn on/off base map layers such as the Aerial photo (if 
the facility has Mr Sid data, it can be displayed), so that you can see 
the facilities and roads better. By clicking on the corresponding 
checkbox, the layer will either display the layer or not.  
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The other two sections, Plot Type and Material / Chemical, are used 
only for CBR Simulations. They will come up blank before the start of a 
CBR Simulation run and are dynamically updated whenever plots are 
created by running SCIPUFF. The user can select only one plot type 
(choose from Surface Dosage, Surface Deposition, or Concentration 
plots) and one material/chemical release at a time. If the user wishes to 
view another material/chemical or plot type, simply check the radio 
button for the alternate selection during simulation and the JeoViewer 
will change to view a the selected material/chemical or plot type. 

 
Figure A7. Display Control window before simulation executes. 
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 Animation Control: The animation control window only appears 
in the Tools menu when you are running the simulation. Figure A8 
shows the window after the simulation has started, and the Anima-
tion Control menu is selected from the Tools menu. The current si-
mulation time is shown in a non-editable text field. The Simulation 
Update Interval is the time (in simulation units) to have the Jeo-
Viewer display update. The Animation Pause Interval slider bar 
tells the JeoViewer how many seconds (in clock-time) to pause the 
animation of the map between display updates. 

 
Figure A8. Animation Control window, shown during simulation execution 

Mode Selection 

In CBRSim, a user can enter a specific mode (specific CBRSim function) by 
either selecting that mode from the “Select Mode” drop-down menu or by 
clicking on the icon associated with the mode (the modes related to each 
icon are displayed if you hover the curser over the icon for a few seconds). 
Note that a message (or instructions) on how to use the mode are provided 
at the bottom of the CBRSim Main Window. Figure A9 shows the “Select 
Mode” dropdown menu (with “Atmospheric Data” selected) and a series of 
icons that can be clicked to change modes.  

 
Figure A9. “Select Mode” drop-down menu and icons. 
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To verify what mode is assigned to each icon, place the cursor over the 
icon and a window will pop up identifying the mode associated with the 
icon. Figure A10 shows the window that pops up if you leave the curser 
over the “Atmospheric Data” icon for a few seconds. 

Mode selection for CBRSim can be generally grouped into two categories: 

 Navigating/Controlling the JeoViewer 

 CBR Setup 

 
Figure A10. Pop-up Tooltip describing icon mode. 

Navigating / Controlling the JeoViewer 

There are five modes of functionality in the JeoViewer related to naviga-
tion and control: 

 Zoom Mode: indicated by the magnifying glass icon ( ), is the 
default mode. Clicking on the icon or selecting “Zoom” in the drop-
down box will put the JeoViewer in Zoom mode. While in this 
mode, you can click on the map to indicate the upper left of a rub-
ber band box, and drag down to the lower right. Letting go of the 
mouse will then make the JeoViewer zoom to the indicated zoom 
box (Figure 11). 
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Figure A11. The JeoViewer view after a zoom action. 

 Pan Mode: indicated by the arrow icon ( ). By pressing the icon 
or selecting “Pan” in the drop-down box, will put the JeoViewer in 
Pan mode. While in this mode, you can click on the map to indicate 
where the center point of the map image is to be placed. The map 
will be redrawn. 
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 Point Query Mode: indicated by the bold question mark ( ). By 
pressing the icon or selecting “Point Query” in the drop-down box, 
will put the JeoViewer in Point Query mode. To use point query 
simply place your cursor over a location on the map you wish to 
query and click your left mouse button. A dialog box will be dis-
played listing the names of the objects within 10 pixels of the click 
point. (see Figure A12). Selecting one of the items in the Point 
Query list, enables the Zoom and Hi-Lite buttons on the Point 
Query Dialog. Pressing the “Hi-Lite” button cause the correspond-
ing object on the map view to change color. In addition, pressing 
the “Zoom” button automatically zooms in at the location of the se-
lected object. Selecting the Object within the List view, and then 
clicking the tab with the Table view, will show the attributes for the 
particular object (See Figure A13). These attributes are set to the 
values that are read in from the Facilities shapefile for the installa-
tion (values from the corresponding DBF file). Later, during the ex-
ecution of the simulation, other attributes will be available to look 
at, such as the HVAC doors and window state and contamination 
status. 

 
Figure A12. Point Query window after clicking on a building in the JeoViewer window. 



ERDC/CERL TR-09-39 43 

 

 
Figure A13. Point Query window, showing attributes in the table view 

 Box Query Mode: indicated by the question mark in a box icon. 
Selecting this mode, you can use the rubber band box to indicate 
that you want to query everything within that box. The Query Di-
alog will list all objects within the indicated box within the List view 
(like in Figure A13). 

 Distance Tool: indicated by the ruler icon. Selecting this mode, 
you can click on the map and a line-drawing tool will start drawing 
a line as you drag. At the bottom of the screen, in the Message area, 
the total distance will be shown each time you click. Double-click to 
end the distance calculation. 
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CBR Scenario Setup 

JeoViewer modes that are specific to the CBR application are included on 
the Mode Tool Bar along with the default navigation modes (see Figure 
14). To select any of these mode buttons (placing the cursor over the icons 
on the tool bar brings up a tool-tip with the label of the incident modes), 
click on the button. Then after selecting that mode, click the correspond-
ing icon on the map, if one exists, in order to edit it, or click on a location 
on of the map to add a new release of that type at the location. The corres-
ponding Incident Configuration window for the specific release comes up 
with the information for that release (see the following sections). 

 
Figure A14. The Mode toolbar on the main JeoViewer window. 

 Atmospheric Data 

Atmospheric data is necessary for the simulation to execute a CBR release. 
You may also add any number of CBR release incidents, but you need to 
only have a single meteorological event. If you forget to enter atmospheric 
data, a warning dialog will prompt you to do so if you try to run the simu-
lation. There is a default atmospheric reading included with the delivered 
scenario. You can edit it with current parameters. To input atmospheric 
data, select the Atmospheric Data mode (either from the drop-down select 
mode menu or by clicking on the icon) and then move your cursor any-
where over the map and click the left mouse button or just click on the ex-
isting icon on the map. This brings up the Meteorology Input window 
(Figure A15). 
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Figure A15. Meteorology Input window. 

Enter data that will be used for all the releases in the simulation. This data 
will be used by the SEBMET model during the simulation run. Click Apply 
to save the data. Enter temperature (in Celsius), wind speed (m/s), wind 
direction (direction from which the wind comes from i.e. North Wind = 0 
degrees, East = 90, South = 180, and West = 270), relative humidity (%).  

The Cloud Cover drop-down box gives the selection of cloud cover, some-
times referred to as sky condition. The user can specify cloud cover in qua-
litative terms as outlined in Table A1. Table A1 also provides the corres-
ponding three character codes as reported by automated weather stations 
(ASOS) as well as the fraction of sky obscured for the various classes.  

Table A1. Cloud information, for use in SEBMET. 

Cloud Amount ASOS Code Percentage of sky obscured 

Clear CLR 0% 

Mostly Sunny FEW 25% 

Partly Cloudy SCT 50% 

Mostly Cloudy BKN 75% 

Overcast OVC 100% 
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The second parameter describing cloud observations is ceiling height, 
which refers to the height above ground of the cloud base. The user can 
enter one of three qualitative ceiling height classes outlined in Table A2. 
Click Apply to save any changes. 

Table A2. Cloud height categories, for use in SEBMET. 

Qualitative 
Category 

Ceiling Height 
Range [m] 

Description 

Low 0 – 2000 Dark, heavy appearance. Also can be puffy or broken as in 
cumulus or stratocumulus clouds. Sun not visible through 
clouded areas. 

Mid Level 2000 – 5000 White, or light grey colored clouds, sometimes with ripples. 
Also can appear as bluish veil or layer of clouds with no 
detail, through which the sun may be dimly visible. 

High 5000 – 15000 Thin wispy clouds or cloud layers. Sometimes associated 
with halos around the sun or moon. Sun and bright stars 
usually visible through these clouds. 

 

 CBR Incidents  

The CBRSim allows the user to assign five different types of CBR release 
incidents: 

 Chem/Bio Weapon Incident – Hazard Prediction and Assessment 
Capability (HPAC) Incidence Model* 

 Chem/Bio Facility Incident - HPAC Incidence Model 

 Radiological Weapon Incident - HPAC Incidence Model 

 Industrial Chemical Transport Incident - Chemical Accident Sto-
chastic Risk Assessment Model (CASRAM) Incidence Model 

 Industrial Chemical Spray Incident - CASRAM Incidence Model 

CBRSim allows the user to select more than one incident for a simulation. 
However, there is one caveat to running multiple releases during a simula-
tion: you cannot have the same chemical released from an HPAC incident 
model and a CASRAM incident model during the same simulation run. For 
instance, if you select an ammonia release for the Chem/Bio Facility Inci-
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dent you cannot select ammonia for an Industrial Chemical Transport In-
cident. If you have selected the same chemical for these, a conflict resolu-
tion window will appear that can be used to resolve the conflict (see run-
ning the simulation section below). 

 Chem/Bio Weapon Incident 

To enter information needed to run the CBRSim Chem/Bio Weapon Inci-
dent, either select the “Chem/Bio Weapon Incident” from the Select Mode: 

drop-down menu or click on the  icon. Then move your cursor over the 
point on the map where the release should be located and click the left 
mouse button. A confirmation dialog box will come up to verify that you 
want to create a new Incident at that location (Figure A16).  

 
Figure A16. Confirmation dialog box for a new chem/bio weapon incident. 

Select “Yes” in the confirmation dialog box to bring up the Incident Confi-
guration Window (Figure A17). 

 
Figure A17. Incident configuration window for chem/bio weapon incident. 
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At this point, you may enter/edit any variables, cancel (which will close the 
window), or Delete the incident. Note that CBRSim application is automat-
ically loaded with an example: CBWeapon release (for Sarin) already 
placed on the map (Figure A18). 

 
Figure A18. CBWeapon Sarin example incident loaded into CBRSim. 

To edit the information entered in the pre-loaded example for Sarin re-
lease, select the Chem/Bio Weapon Incident mode icon ( ) and then click 
the corresponding icon on the map (Figure A18). Information about this 
release can then be edited, or the release can be deleted. The icon will be 
removed from the map, showing that it is deleted. 

Referring to Figure A18, at this point, you may enter/edit any variables, 
cancel (which will close the window), or Delete the incident. The Latitude 
and Longitude will be filled in for you from the location you clicked on the 
map. Altitude is editable, and refers to the height at which the weapon will 
explode and release its agent. The value is in meters. At the bottom of the 
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window, you can choose how many hours offset into the simulation this 
release is to occur. 

The middle section of the window is where the user defines the HPAC-
CBWeapon-specific parameters. There are pre-defined Munition Types in 
the drop-down box that set default parameters based upon expert opinion 
and experiments in the field. After selecting a munition type, the Delivery 
System drop-down box will fill with relevant values for that munition type. 
The agent needs to be chosen from the available agents that are usually 
contained within the chosen weapon delivery system. Refer to the HPAC 
User’s Manual for a detailed description of the relation of munition types, 
delivery systems, and agent. 

Lastly, under the Technical Description section, the only parameter that 
CBRSim allows the user to edit is the Mass of Load (kg). This is the agent 
payload of the munitions. The rest of the parameters that are editable 
within HPAC are set to the defaults for simplicity in CBRSim setup. 

 Chem/Bio Facility Incident 

To enter information needed to run the CBRSim Chem/Bio Facility Inci-
dent, either select the “Chem/Bio Facility Incident” from the Select Mode: 
drop-down menu or click on the  icon. Then move your cursor over the 
point on the map where the release should be located and click the left 
mouse button. A confirmation dialog box will come up to verify that you 
want to create a new Incident at that location. Select “Yes” in the confirma-
tion dialog box to bring up the Incident Configuration Window (Figure 
A19). 

At this point, you may enter/edit any variables, cancel (which will close the 
window), or delete the incident. The Latitude and Longitude will be filled 
in from the location you clicked upon the map. Altitude is grayed out since 
this incident model assumes the release is near the ground at a facility. At 
the bottom of the window, you can choose how many hours offset into the 
simulation this release is to occur. 

The CBFacility-specific values are shown in the middle section of the win-
dow. The Model Type refers to the HPAC options for this incident model. 
The default one, Damage Category, is the only one offered through 



ERDC/CERL TR-09-39 50 

 

CBRSim as it is the easiest to use. So, that drop-down box has no other se-
lections available at this time. 

The Damage Category severity drop-down box lets the user chose between 
Light, Moderate, Severe, or Total severity of damage done to the target. 
Next, the agent is chosen from the list of available agents within CBRSim. 
The last piece of information that is needed is the mass (in kg) of the agent 
that is contained within the target. It is assumed that the target of the at-
tack is an agent within a confined container within the facility. These pa-
rameters are used within the HPAC CBFAC incident model and when the 
simulation is run, it will calculate the amount of viable agent released from 
the type of severity selected. These values are not shown in the interface, 
but are passed into the HPAC SCIPUFF model. 

 
Figure A19. Incident Configuration Window for chem/bio facility incident. 

 Radiological Weapon Incident 

To enter information needed to run the Radiological Weapon Incident, ei-
ther select the “Radiological Weapon Incident” from the Select Mode: 

drop-down menu or click on the  icon. Then move your cursor over the 
point on the map where the release should be located and click the left 
mouse button. A confirmation dialog box will come up to verify that you 
want to create a new Incident at that location. Select “Yes” in the confirma-
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tion dialog box to bring up the Incident Configuration Window (see Figure 
A20). At this point, you may enter/edit any variables, cancel (which will 
close the window), or delete the incident. Like the other incident screens, 
the Latitude and Longitude will be filled in from the click location on the 
map. The Altitude is grayed out and assumed to be on the ground. At the 
bottom of the window, you can choose how many hours offset into the si-
mulation this release is to occur. 

 
Figure A20. Incident Configuration window for radiological weapon incident. 

Figure A20 shows the default incidence characterization window for a  
radiological weapon incident. The middle section defines the HPAC-
RWPN-specific parameters for an explosive Radiological Dispersal Device 
(RDD), which is assumed as the source of the radioactive material. The 
“High Explosive Mass” field must be entered by the user. This field is au-
tomatically filled in with a default of 0, but the user must make sure to give 
it a valid weight (in kg.) The default “Material Type” is set to Americum-
241 and the “Material Form” is default to Salt/Powder. The user may select 
from a list of 18 available radioactive materials. The drop-down box for 
material forms fills in with the appropriate values for the Material Type 
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chosen. The radioactive material mass must also be entered. This field is 
the amount (in kg) of the actual radioactive material within the RDD. 
There are three options that are also needed, “Calculation Radius, Expo-
sure Duration, and Cloud Dose. The calculation radius refers to the effec-
tive range of the incident. The default value is 500 km. Exposure duration 
is the time that the exposure occurs. Default value is 24 hours. Lastly, the 
cloud dose option choices are “Cloud Shine” and “Air Submersion.” Air 
Submersion is the default, and is a faster, but less accurate calculation. 

After editing all the variables, press Apply to save the data and create the 
incident. After the Apply button is clicked, a corresponding icon ( ) is 
shown on the map at the location that was clicked.  

 Industrial Chemical Transport Incident 

To enter information needed to run the CASRAM-specific Industrial 
Chemical Transport Incident, either select the “Industrial Chemical Inci-
dent” from the Select Mode: drop-down menu or click on the truck (  ) 
icon. Then move your cursor over the point on the map where the release 
should be located, and click the left mouse button. A confirmation dialog 
box will come up to verify that you want to create a new Incident at that 
location. Select “Yes” in the confirmation dialog box to bring up the Inci-
dent Configuration Window (Figure A21).  

At this point, you may Enter/Edit any variables, Cancel (which will close 
the window), or Delete the incident. The Latitude and Longitude will be 
filled in from the location you clicked upon the map. Altitude is grayed out, 
since this incident model assumes the release is near the ground at a facili-
ty. At the bottom of the window, you can choose how many hours offset 
into the simulation this release is to occur. 

The user then picks the type of chemical that is being transported. The 
middle section defines the type of container the agent is being transported 
within, as well as its capacity (See Table A3 for the types of containers that 
can be chosen, along with the typical size). If the container type is Drums 
or Cylinders, the window will change to enter the number of containers. 
Otherwise, if a type of Tank or Truck is the chosen container, the window 
shows fields for entering the size of the hole where the container has been 
breached and is spilling the contents, and the location of the hole within 
the container. Circular holes are the assumed shape, and the hole size is 
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defined by the diameter. For “worst case” incidents use 100 cm. The loca-
tion of the hole in the container is important, since it limits the amount of 
the material escaping from the container, and influences the flow rate of 
liquids from the hole. This is given as the percentage of container height, 
as estimated from bottom to where the hole is located. (Bottom is 0, top is 
100.) For “worst case” incidents, use 0 (hole at bottom). 

The Surface Type drop-down box is the type of surface upon which the 
agent is spilling. Selections are Natural (meaning ground, terrain), As-
phalt, and Concrete. 

Lastly, the Default Pool Depth is the default selection for estimating the 
size of the pooling chemical on the ground. If you have an indication of the 
actual size of the pool, for example, a diked region around tanks in a tank 
farm, select Pool Area (m2), and then type in the squared area’s value in 
the text field, next to the drop-down box. The user may also select Equili-
brium Depth (for free-standing pools that spread without restriction) and 
enter the value in millimeters in the text box. 

Table A3. Container types for industrial chemical transport incident model. 

Container Type Notes Typical Size 

111A Tank Car Std rail car for hazardous liquid materials 20000 gal. 

105; 112 Tank car Std rail car for hazardous materials under 
pressure 

20000 gal. 

MC306 Tank Truck Highway cargo tank for flammable liquids 6000 gal. 

MC307 Tank Truck Highway cargo tank for flammable liquids, weak 
acids and wastes 

6000 gal. 

MC312 Tank Truck Highway cargo tank for toxic liquids and acids 4000 gal. 

MC331 Tank Truck Highway cargo tank for hazardous materials under 
pressure 

8000 gal. 

Drums Package freight: 5-200 gallon drums 55 gal. 

Cylinders Package freight 1-100 gallon cylinders 19 gal. 

 

Use MC312 and MC331 for highway liquids and gases. Note that this pa-
rameter currently has little influence on the results, except for Drum and 
Cylinder containers (all of the agent within Drum and Cylinder containers 
is assumed to be released). 
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Figure A21. Incident Configuration window for industrial chemical transport incident. 

Figure A21 shows a release of Benzene from an 111A Tank Car (the user 
may select from a long list of available chemicals). The size of the Contain-
er is 20,000 gallons (container size can also be provided in kg or pounds), 
and the hole size is 100 cm located at the bottom of the container (% from 
the bottom: 0% = bottom hole, 100% = hole on top). Leaving a Default 
Pool Depth will let CASRAM choose what is appropriate for the particular 
release. The incident will occur at the 0-hour mark in the simulation run 
(unless set by the user to start some time (in days, months, milliseconds, 
seconds, weeks, years, hours, or minutes) after the simulation starts . After 
editing all the variables, press Apply to save the data and create the inci-
dent. After the Apply button is clicked, a corresponding icon ( ) is shown 
on the map at the location that was clicked.  

 Industrial Chemical Spray Incident 

To enter information needed to run the Industrial Chemical Spray Inci-
dent, either select the “Industrial Chemical Spray Incident” from the Select 
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Mode: drop-down menu or click on the airplane (  ) icon. Then move 
your cursor over the point on the map where the release should be located 
and click the left mouse button. A confirmation dialog box will come up to 
verify that you want to create a new Incident at that location. Select “Yes” 
in the confirmation dialog box to bring up the Incident Configuration 
Window (Figure A22). At this point, you may enter/edit any variables, 
cancel (which will close the window), or delete the incident. . The Latitude 
and Longitude will be filled in from the location you clicked upon the map. 
Altitude of the spray release needs to be entered. It is assumed that the 
agent is being dispersed from a plane. At the bottom of the window, you 
can choose how many hours offset into the simulation this release is to oc-
cur. 

Next, choose the Chemical being sprayed from the airplane from the drop-
down list. The release rate needs to be input in mass per second (either kg 
or pounds). The release duration is the duration of the spray release in 
seconds. Lastly, the speed (km / hour) and heading of the plane need to be 
entered for calculating the end points of the linear release for the disper-
sion model. After entering the data, click Apply to save the data.  

 
Figure A22. Incident Configuration window for industrial chemical spray release. 

Figure A22 shows an example values for a Chemical Spray Release inci-
dent. The altitude (in meters) is 200.0. Ammonia is the selected chemical 
(several other chemicals are available in the drop-down menu). This am-
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monia is released at a rate of 100.0 kg/second (the user can also provide 
rates in pounds/second) for a duration of 900 seconds at a speed of 50 
kph and heading 200.0 (compass heading). This release is not offset into 
the simulation (offset set to 0), meaning the release will start at the begin-
ning of the simulation. 

Running the CBR Simulation 

After the user has entered all incident information, the CBR Simulation is 
ready to run. To run the simulation, select “Start Simulation” from the 
Run drop-down menu (Figure A23). 

 
Figure A23. "Start Simulation" option on the "Run" drop-down menu. 

Selecting the “Start Simulation” option will bring up the “Simulation Man-
ager Window” (Figure A24).  

 
Figure A24. The Simulation Manager window. 

Resolving Data Conflicts 

There is only one caveat to running multiple releases during a simulation: 
You cannot have the same chemical released from both an HPAC incident 
model, and a CASRAM incident model, during the same simulation run. If 
this happens, a Release Conflict window will appear when you click 
“Start,” which allows you to resolve the conflict before running (Figure 
A25). 
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Figure A25. The Release Conflicts window, showing the conflicting ammonia releases. 

Following the instructions on the window, select which of the Ammonia 
releases you want to use for the simulation. Figure A26 shows the result of 
selecting the Spray release and clicking the right-arrow button, indicating 
that is the release you would like to run, using Ammonia. 

 
Figure A26. The Release Conflicts window, showing the selected releases. 

After resolving the conflicts, press “OK” button and the “Simulation Man-
ager Window” will come up (Figure A24). 

CBR Simulation 

Press the “Start” in the Simulation Manager Window (Figure A24) to start 
up the simulation. When a simulation is started, all selected incident mod-
els are executed. Also, the Meteorological data will be converted to an 
HPAC-readable format after being processed by SEBMET so that both 
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CASRAM and HPAC/SCIPUFF will be working off of the same meteoro-
logical data set. Source data generated by the incident models are passed 
onto the Second-order Closure Integrated PUFF (SCIPUFF) air dispersion 
model within the HPAC software package to generate results.  

The “Simulation Manager Window” (Figure A24) provides information on 
the status of the simulation and allows the user to “Pause”, “Resume”, and 
“Stop” the simulation. At any time during the simulation, you can Pause 
the simulation (in case you want to query anything on the map), but you 
cannot make any changes to the release parameters once the simulation 
has been started. To continue running the simulation, click the “Resume” 
button.  

The progress of the simulation is shown in the progress bar at the bottom 
of the “Simulation Manager Window,” along with the current simulation 
timestamp. After the simulation terminates, or after you press “Stop,” the 
“Start” button will be re-enabled. At this point, you can restart the current 
simulation (with the release parameters reset to the beginning). If you 
want to edit the parameters, or add/remove releases, you must close the 
“Simulation Manager Window.” Then, you can make your edits by clicking 
modes on the Tool Bar and editing the Incident Data windows. Then, when 
you are ready to run again, select the “Start Simulation” option in the 
“Run” drop-down menu. 

Viewing CBR Results While the Simulation Executes 

After the simulation starts up, the SCIPUFF is run every 15-minutes of si-
mulation time and produces plots of surface dosage, surface deposition, 
and concentration for each time step.  

You can bring up the Thematic Legend by selecting the View->Show The-
matic Legend menu item. This legend will show both the facility concen-
tration levels and the selected Plume plot values. Figure 27 shows the Jeo-
Viewer window with the thematic legend and a Sarin 15-minute 
concentration plot. The legend is showing the concentration values for the 
contours in the lower half (Sarin Plumes) and in the upper half, its show-
ing the indoor concentration values calculated by the leaky box model. The 
facilities are colored according to the level of indoor concentration by de-
fault.  
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Figure A27. Main JeoViewer window, showing a concentration plot for Sarin,  

and showing the Thematic Legend. 

During a simulation, the default is to show concentration plots for the first 
material/chemical release selected. Note that only one release  
material/chemical and one plot type can be displayed at one time. To 
change which material/chemical or plot type is displayed, see information 
on “Display Control” explained in the “Menu Items – Tools Menu” section 
above.  

As mentioned previously, turning off the Aerial photo lets you see the dis-
play more clearly. Plot Types that can be selected for display are Surface 
Dosage, Surface Deposition, and Concentration. To display the results of a 
different material/chemical release, select it from the Material / Chemical 
section of the “Display Control” window. When alternative mate-
rials/chemicals and plot types are selected, the display and the thematic 
legend update accordingly. Often, there may not be any discernable plots 
on the map due to the fact that the concentration values are less than the 
minimum contour level. In that case, you will not see anything displayed 
when selecting that plot type. Figure A28 shows the Display Control win-
dow during the execution of the simulation. 
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Figure A28. The Display Control window, showing the selections available 

 to view during simulation execution. 

Occasionally, there are very small values for a released material/chemical. 
In these cases, the Thematic Legend will be initialized with only two con-
tour levels. This may cause the entire region to display as red (the “lowest” 
value) due to the fact that every value may be extremely small. This is an 
artifact of the way HPAC/SCIPUFF is run within CBRSim. 

While the simulation is executing, you can zoom, pan, and select plot dis-
plays from the JeoViewer navigation tools, as well as Pause, Resume, or 
Stop the simulation from the Simulation Control window. The SCIPUFF 
model is being called every 15 simulation minutes, and the display is up-
dated with each time step. At the end of the simulation time, the Simula-
tion Manager Window will re-enable the Start button and the status will be 
shown as terminated.  
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Leaky Box Modeling 

In addition to CBR air dispersion modeling, the CBRSim application also 
includes a Leaky Box Model that models the indoor concentration levels 
for each facility and for each material/chemical released in the CBR inci-
dent models. The Leaky Box model automatically runs and uses concentra-
tion data generated by the SCIPUFF model and building data that has 
been uploaded with the facility data as inputs.  

Output from the Leaky Box Model results are displayed visually in the 
CBRSim Main JeoViewer Window. Facility outlines are assigned colors 
based on their concentration level. The Thematic Legend will automatical-
ly display a legend for the facility concentrations. Even though you may be 
viewing plots of different types (surface dosage or surface deposition), only 
concentrations are calculated for facilities. When the user selects a differ-
ent material/chemical using the “Control Display” window, the facilities 
display will automatically change to reflect the concentrations of the new 
material/chemical. The Thematic Legend will also be updated to display 
the legend for the new material/chemical. By keeping the Facilities drop-
down box in its default choice (blank), the facility concentration will con-
tinue to be displayed.  

Exiting CBRSim 

To quit the system, select File->Exit. Exiting the CBRSim client gets rid of 
the main Java process, but the associated DOS window remains active. It 
will read “Press any key to continue…” Just close the window. Since 
ICE/HPAC, the HPAC Model Controller, and the CORBA naming server 
are all separate processes with their own DOS windows, you will need to 
close each of the windows when you are ready to exit. Otherwise, you 
should not restart the CBRSim application because it will try to start up all 
the processes again. (Don’t forget to close the tnameserver window, it may 
be minimized in the Task bar.) 

CBRSim Directory and File Structure 

The CBRSim installer includes a fictional Fort Readiness. The FFVI install 
directory contains the needed files for creation of the JeoViewer layers and 
definition files as well as the DOS bat scripts and executables for the in-
stallation-specific simulation. If you installed in the default directory, for 
example, c:\Program Files\FFVI_Readiness, all the files needed for that 



ERDC/CERL TR-09-39 62 

 

installation’s simulation is within that directory hierarchy. The shortcut 
created on the desktop points to this directory and the fortfuture.bat file. 
Here is a synopsis of the files you’ll find there: 

 Top-level dir: fortfuture.bat file and HPAC.bat file along with the 
desktop shortcut and FF icon. These are the only relevant files in 
this directory. 

props – Java property files needed by the CBRSim application 

 mtlFiles.zip – this file contains the edited HPAC material file direc-
tory needed for CBRSim. Argonne added chemicals that were not 
included in HPAC, but were modeled in CASRAM and edited exist-
ing material files for use in CBRSim. The installation script un-
zipped this file automatically in the HPAC4\server\data\materials 
directory after zipping up the original files that got installed with 
HPAC. 

• CamStudio – this directory contains the open source CamStudio 
software. The Recorder.exe is called from the CBRSim main win-
dow when choosing Run->Run Snapshot Recorder. The Player.exe 
is used for playback of a recorded session. 

o GeoData 

 readiness.dat – this is the JeoViewer frame definition 
file. This file describes the JeoViewer layer definition 
files and also describes the Projection that the JV uses 
to load the installation shapefiles. The topological da-
ta for the installation is expected to be named 
lfhypgd_five_foot.shp (and its attending other files), 
and the Projection is expected to be: 

 PROJCS["NAD_1983_UTM_Zone_13N", 

 GEOGCS["GCS_North_American_1983", 

 DATUM["D_North_American_1983", 
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 SPHEROID["GRS_1980",6378137.0,298.257222101]]
, 

 PRIMEM["Greenwich",0.0], 

 UNIT["Degree",0.0174532925199433]], 

 PROJECTION["Transverse_Mercator"], 

 PARAMETER["False_Easting",1640416.666666667], 

 PARAMETER["False_Northing",0.0], 

 PARAMETER["Central_Meridian",-105.0], 

 PARAMETER["Scale_Factor",0.9996], 

 PARAMETER["Latitude_Of_Origin",0.0], 

 UNIT["Foot_US",0.3048006096012192]] 

 CASRAM – directory for the Fortran programs CASRAM and 
SEBMET and their associated data files. 

 jar – directory containing all the Java jar files for running CBRSim 

 jre – directory containing the Java 1.5 runtime executable. By in-
stalling the jre along with the installation data, the user does not 
have to do a system install of Java nor have to affect any version he 
may have already installed on his computer. The CBRSim will use 
this jre for executing. 

 lib – directory containing the native libraries needed for CBRSim 
(whereas the FFVI can run on multiple Operating Systems (linux, 
windows, and mac os x), the HPAC model is only available for Win-
dows systems. 

 Locations\Readiness (or FtCarson) – this directory contains the da-
ta files for the JeoViewer (GeoData) and for initializing the process 
model (ScenarioData). The file names between the 2 installations 
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are identical. To create Fort Carson, the Fort Readiness is used as a 
template and the files copied to the Locations directory of the new 
installation. The file names remain the same, but the contents of the 
following files may be edited to create the site-specific information 
used in the simulation: 

o GeoData 

 readiness.dat – this is the JeoViewer frame definition 
file. This file describes the JeoViewer layer definition 
files and also describes the Projection that the JV uses 
to load the installation shapefiles. 

 layer_defs – this directory holds the layer definition 
files pointed to from the readiness.dat file:  
Background.def is the main file which describes all the 
layers and the styles for displaying the data in the JV. 

 boundary – this directory holds the ESRI shapefiles 
for the installation boundary 

 facilities – this directory holds the ESRI shapefiles for 
the building footprints for the installation. The names 
of the HVAC fields to be included in the file for impor-
tant buildings are: 

• HVACField fieleName=”EXCH_HVAC” de-
fault=”2.0” 

• LeakageOpenField fieldname=”EXCH_HVAC” 
default=”2.0” 

• LeakageClosedField filename=”EXCH_HVAC” 
default=”.5” 

 network – holds the ESRI shapefiles for the installa-
tion road network 

o ScenarioData 
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 DB – this directory contains the optional personnel, 
vehicle, and/or equipment files. These comma-
separated files are used to initialize the attributes of 
the agents that will be modeled within the Process 
Model. Personnel in the case of CBRSim will be doing 
their daily work, and will react by sheltering-in-place 
during a contamination event. 

 testdb3.xml – this is the user-editable scenario setup 
file written in eXtensible Markup Language (XML). 
The corresponding scenario.dtd file is used to validate 
the XML. This file is used to define the actions and 
reactive plans that the agents will be using (in this 
case to shelter-in-place) as well as the holding the 
time frame of the simulation run, the filenames of the 
road network and facility shapefiles, and default 
HVAC values for the buildings. It is optional to run 
the process model and it is disabled for Fort Readi-
ness, but enabled for Fort Carson. The default time 
frame is Jan 1, 2020 to Jan 3, 2020.  

 ContourColors.xml (.dtd) – these files define the con-
tour colors shown within the thematic legend. There is 
no need to have to edit these files. 

At a minimum, the building shapefile and road network shapefiles are 
needed for the CBRSim simulation. Other installation-specific ESRI sha-
pefiles can be imported and shown in the JeoViewer, but are not used in 
the simulation part of the system. If other types of files are to be imported, 
the GeoData\readiness.dat file can be edited to define a Shapefile Loader 
and the projection that it’s in, as well as a reference to the file location. 
Then a layer and style need to be defined in the Background.def file for 
rendering it in the JeoViewer. The editing of these files is beyond the scope 
of this document. 
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Appendix B: Building Air Change Rate 
Estimates for CBR Analysis 

Note: The following text is extracted from draft Letter Report entitled 
Building Air Change Rate Estimates for CBR Analysis, written by Andrew 
Persily, Building and Fire Research Laboratory, National Institute of Stan-
dards and Technology, Gaithersburg MD dated 15 September 2008, to 
ERDC-CERL. 

Introduction 

Building air change rates impact energy consumption for space condition-
ing and indoor contaminant levels in relation to general indoor air quality 
issues as well as occupant exposure to airborne chemical, biological and 
radiological (CBR) agents. With respect to contaminant levels, air change 
rates impact both the entry and subsequent dilution of agents with out-
door sources and the dilution of those released internally.  

The air change rate of a particular building at a given time is a function of 
building layout, HVAC system design and operation, the operation of other 
building systems such as exhaust fans and vented combustion equipment, 
building envelope airtightness, exterior weather conditions, and occupant 
actions, e.g. window and door opening. These dependencies can lead to 10-
to-1 or even larger variations in the air change rate of a given building, and 
even larger variations between buildings.  

The most reliable means of determining a building’s air change rate under 
specific conditions is to measure it with a tracer gas technique. Other mea-
surement methods exist, but they are do not necessarily characterize all of 
the relevant airflows (i.e. outdoor air intake traverses that don’t account 
for envelope infiltration, or are often associated with higher levels of mea-
surement uncertainty. However, such measurements would need to be re-
peated under a range of conditions to generate a complete understanding 
of the building’s air change rates for all situations of interest. Alternatively, 
modeling approaches exist that can predict these rates with an acceptable 
level of accuracy, assuming the required input data has been determined 
for the building of interest (ASHRAE 2005). 
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However, measurement and modeling is not always an option in a given 
building, and generic values may be more useful that building-specific 
rates to support certain types of analyses. Since such estimates are not 
building specific, they are associated with some level of uncertainty, but 
they are still useful as long as their approximate nature is understood. 

This note presents air change rate estimates for a number of different 
building types: offices, homes, schools (including child development cen-
ters), barracks, multi-family residential buildings, retail buildings, restau-
rants, theaters, hospitals, gymnasiums, warehouses, and commissaries. 
These rates can be used to specify building air change rates for buildings 
that are included in the CBRSim Model. 

A table is presented for each building type, based on design requirements 
in ASHRAE Standard 62.1 or 62.2, as appropriate (ASHRAE 2007a and 
2007b), the limited measurements available (which do not exist for some 
building types), and engineering judgment. 

In each building type table, the air change rate values are color coded to 
indicate the associated level of confidence. Air change rates based on de-
sign values or field measurements are shown in black, and are associated 
with an uncertainty of about 25%, though in some cases the uncertainty 
could be larger. Those shown in blue are based on very limited measure-
ments or design considerations, and are noted to have an uncertainty of 
roughly 50%. The values in red are noted as being very speculative, and 
are associated with an uncertainty of 100%. These uncertainty values are 
all approximate, and in some cases, quite large due to the limited number 
of field studies that have taken place, and the building, weather, and sys-
tem operation impacts on air change rates. 

The user should be aware that without building and condition specific 
measurements, air change rates estimates are inherently approximate, but 
can still be useful for certain analyses. 
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Air change rates for building types 

Offices 

Table B1. Office building air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation Only     
Standard 62.1 minimum rate  0.75    
Standard 62.1, under ventilation 0.38    
Standard 62.1, over ventilation 1.13    
Economizer operation 3 to 5    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  0.75 0.9 1.1 
Average tightness  0.9 1.1 1.5 
Very leaky  1.1 1.5 2.0 

Mechanical combined with open windows 1.5 2.5 3.5 
     

EPA BASE study     
All data – mean (S.D.) 1.8 (2.1)    
Minimum outdoor air – mean (S.D.) 0.5 (0.4)    

Based on measured or design values, +/- 25% 
Based on limited measured or design values, +/- 50% 
Very speculative, at least +/- 100% 

 
Table B1 presents the air change rate values for office buildings. These val-
ues fall into several categories, the first three being mechanical ventilation, 
infiltration and open windows. In each of these cases, the air change rates 
are associated with only that mechanism in effect. The Standard 62.1 min-
imum rate corresponds to roughly 10 L/s (20 cfm) per person of outdoor 
air ventilation, five occupants per 100 m2 of floor area and a 2.4 m (7.9 ft) 
ceiling heights.*

                                                                 
* The standard expresses area in terms of thousands of square feet (1,000 ft2). 

 Other ventilation rates, occupant densities, and ceiling 
heights correspond to different air change rates per the following formula: 
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 Air change rate = 0.036 Q N / H 

where: 

 Q = outdoor air ventilation rate per person in L/s,  
 N = number of occupants per 100 m2 of floor area 
 H = ceiling height in m.  

The next two entries in the table under the Standard 62.1 category, under 
ventilation and over ventilation, correspond to a 50% decrease and a 50% 
increase in the Standard 62.1 air change rate. Given the realities of system 
operation and maintenance, outdoor air intake rates often deviate from 
their design values. A 50% deviation is not unreasonable, based on the re-
sults of existing field studies (Persily and Gorfain 2004). 

A third condition is included under mechanical ventilation, which is a 
range of rates under economizer operation in which the outdoor air intake 
fraction is increased to cool the building, as an energy savings measure, 
relative to using mechanical cooling equipment. Not all buildings are 
equipped with an economizer cycle, but those that do have air change rates 
in the noted range. 

However, the rates in a particular building depend on the system design 
and operation, as well as the outdoor air temperature, which can lead to 
lower air change rates when it is colder outside. Also, note that a specific 
building may or may not have been designed to comply with Standard 
62.1-2007, but rather with an earlier version, some of which had outdoor 
air requirements as low as 2.5 L/s (5 cfm) per person in office space. 

The three cases for infiltration-only correspond to three generic levels of 
building tightness, and include a generic dependence on weather, from 
calm to severe. These characterizations of building tightness and weather 
are inherently approximate, and are not based on any specific numerical 
values or simulations. Therefore, the air change rates are noted as less cer-
tain than the design-based values. The open-windows values are even 
more approximate than the infiltration-only cases, as they ignore the wide 
variation in window opening patterns that might occur in a given building, 
and because of the lack of measurements of office building air change rates 
under these conditions.  
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Additional values are included for mechanical ventilation, in combination 
with envelope infiltration, for three levels of building tightness and three 
levels of weather. An additional set of values is included for mechanical 
ventilation in combination with open windows and three levels of weather.  

The final two rows of the table present the mean air change rate (and the 
standard deviation) from the Environmental Protection Agency (EPA) 
Building Assessment Survey and Evaluation (BASE) study (Persily and 
Gorfain 2004). The BASE study was conducted in a random sample of 100 
office buildings across the United States, and the values in the table cor-
respond to the measurements made in the spaces involved in the study. 
The first of the two rows is based on all these data, while the last row in-
cludes only measurements conducted under minimum outdoor air intake. 

Homes 

Table B2 presents the air change rate values for single family homes. The 
first set of entries correspond to mechanically ventilated buildings in 
which a mechanical system brings outdoor air into the home. Note howev-
er that very few single family homes in the U.S., even new ones, use me-
chanical systems for outdoor air ventilation. These first three entries 
present the ventilation requirements in ASHRAE Standard 62.2, which 
depend on house size and number of bedrooms per the following equation: 

 Air change rate = 3.6 [0.05 Af + 3.5 (nb + 1) + 0.1 Af] / (Af * H) 

where: 

 Af is the floor area in m2 
 nb = number of bedrooms 
 H is the ceiling height in m.  

The third term in the square brackets, (0.1 Af) is an infiltration credit the 
standard uses to account for an assumed level of infiltration air entering 
the building that contributes to meeting the overall ventilation require-
ment.  

The next entry is the mechanical ventilation requirement, based on the 
U.S. Department of Housing and Urbana Development (HUD) Manufac-
tured Housing Construction and Safety Standards (HUD 1994). The HUD 
outdoor air ventilation requirement of 0.018 L/ s•m2, which is based only 
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on floor area, and hence, there is only a single entry, assuming a ceiling 
height of 2.4 m.  

The next three entries are for envelope infiltration only for three different 
cases of airtightness, and three cases of weather conditions. These values 
are followed by a very speculative set of values for ventilation via open 
windows. 

Table B2. Single-family home air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.2 requirements     
150 m2, 2 bedrooms 0.32    
200 m2, 4 bedrooms 0.35    
300 m2, 6 bedrooms 0.34    
HUD manufactured house requirements 0.26    

Infiltration Only     
Very tight building  0.1 0.25 0.6 
Average tightness  0.25 0.6 1.0 
Very leaky  0.5 0.9 1.5 

Open Windows Only  1 3 5 
     

Mechanical ventilation (Standard 62.2) combined with infiltration 
Very tight building  0.25 0.4 0.7 
Average tightness  0.5 0.7 1.1 
Very leaky  0.6 1.0 1.6 

Mechanical ventilation (HUD) combined with infiltration 
Very tight building  0.35 0.4 0.75 
Average tightness  0.4 0.8 1.2 
Very leaky  0.7 1.0 1.7 
     

Mechanical (62.2) combined with open windows 1 3 5 

Mechanical (HUD) combined with open windows 1 3 5 
     

NIST U.S. homes analysis     
All data – median 0.45    
Built before 1940 – median 0.60    
Built between 1941 and 1969 – median 0.55    
Built between 1970 and 1989 – median 0.35    
Built after 1990 – median 0.25    
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Pandian U.S. homes database     
All data – median 0.50    

Based on measured or design values, +/- 25% 
Based on limited measured or design values, +/- 50% 
Very speculative, at least +/- 100% 

 
Additional values are included for mechanical ventilation in combination 
with envelope infiltration for three levels of building tightness and three 
levels of weather. These values are presented first with the mechanical 
ventilation rate based on Standard 62.2 and then with the rate derived 
from the HUD standard. In the case of the Standard 62.2 combined me-
chanical and infiltration values, the “infiltration credit” is replaced with an 
infiltration rate that depends on building tightness and weather condi-
tions. This adjustment is more realistic than a single value, but still over-
simplifies reality. Two values are also included for the two mechanical ven-
tilation rates in combination with open windows. 

The last two sections of Table B2 present the results for two key studies of 
residential ventilation rates. 

The first is a based on a collection of about 200 residences defined to 
represent 80% of the U.S. housing stock (Persily, Musser, and Leber 
2006). This set of dwellings was defined based on an analysis of national 
housing surveys and subsequently used to develop a national frequency 
distribution of building ventilation rates under infiltration-only conditions 
(Persily and Musser 2007). Median values are presented for all the single-
family homes in the analysis and for those homes broken down by year of 
construction. Note that these median values are much lower than many of 
the estimates earlier in the table, particularly those corresponding to more 
severe weather. However, given the relative infrequency of severe weather, 
those high rates do not occur very often and therefore do not impact the 
median rate very significantly. 

The final entry in Table B2 is the median air change rate from a database 
of measured air change rates in almost 300 homes located throughout the 
U.S. (Pandian et al. 1998). Note that the homes considered in this database 
are not statistically representative of the U.S. housing stock and the mea-
surements were made under weather conditions that do not fully charac-
terize the climatic variations over a year. 
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Schools 

There have been very few ventilation measurements in schools, certainly 
not enough to support a representative value being put forward for general 
use. In addition, the great variety of building configurations and system 
types makes any such generalization even more difficult. 

Table B3 presents air change rates based primarily on the design require-
ments in ASHRAE Standard 62.1, with some speculative estimates of the 
impacts of infiltration and natural ventilation through open windows. This 
table covers elementary classrooms, lecture classrooms and child care cen-
ters separately, with the design rates based on the following three formu-
las; 

 Elementary classrooms: Air change rate = 0.036 [5 D + 60] /H 
 Lecture classrooms: Air change rate = 0.036 [3.8 D + 30] /H 
 Child care centers: Air change rate = 0.036 [5 D + 90] /H 

where:  

 D = number of occupants per 100 m2 of floor area 
 H = ceiling height in m. 

Table B3. Educational building air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

ELEMENTARY CLASSROOM     

Mechanical Ventilation     
Standard 62.1 rate no infiltration 3.2    
Standard 62.1, under ventilation 1.6    
Standard 62.1, over ventilation 4.8    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  3.2 3.4 3.6 
Average tightness  3.4 3.6 4.0 
Very leaky  3.5 4.0 4.5 

Mechanical combined with open windows 4 5 6 
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LECTURE CLASSROOM     

Mechanical Ventilation     
Standard 62.1 rate no infiltration 2.8    
Standard 62.1, under ventilation 1.4    
Standard 62.1, over ventilation 4.2    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  2.8 3.0 3.2 
Average tightness  3.0 3.2 3.6 
Very leaky  3.2 3.6 4.0 

Mechanical combined with open windows 3.5 4.5 5.5 

 

CHILD CARE CENTER     

Mechanical Ventilation     
Standard 62.1 rate no infiltration 4.2    
Standard 62.1, under ventilation 2.1    
Standard 62.1, over ventilation 6.3    

     
 Weather 

independent Weather  Weather 
independent 

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  4.2 4.3 4.5 
Average tightness  4.3 4.5 5.0 
Very leaky  4.5 5 5.4 

Mechanical combined with open windows 5 6 7 
Based on measured or design values, +/- 25% 
Based on limited measured or design values, +/- 50% 
Very speculative, at least +/- 100% 
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Barracks and Multi-Family Residential 

Table B4 presents the air change rate values for barracks buildings. The 
first entry under mechanical ventilation with no infiltration is based on the 
requirements in ASHRAE Standard 62.1 of 2.5 L/s per person plus 0.30 
L/s per m2 of floor area, assuming an occupant density of 10 people per 
100 m2 of floor area and a ceiling height of 2.4 m (7.9 ft). Other occupant 
densities and ceiling heights will correspond to different air change rates 
per the following formula: 

 Air change rate = 0.036 [2.5 D + 30] /H 

where: 

 D = number of occupants per 100 m2 of floor area 
 H = ceiling height in m.  

The values in Table B4 fall into three categories: mechanical ventilation, 
infiltration only, and open window, similar to those used in the previous 
tables. There is not a body of ventilation rate measurements in barracks to 
use in supporting these values, therefore all but the values based on Stan-
dard 62.1 are presented as very speculative. 

Table B4. Barracks building air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 0.8    
Standard 62.1, under ventilation 0.4    
Standard 62.1, over ventilation 1.2    
Infiltration Only     

Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 
Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  0.8 1.0 1.2 
Average tightness  1.0 1.2 1.5 
Very leaky  1.2 1.5 2.0 
Mechanical combined with open windows 1.5 2.5 3.5 
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Based on measured or design values, +/- 25% 
Very speculative, at least +/- 100% 

 

Table B5 presents the air change rate values for multi-family residential 
buildings. The first entry under mechanical ventilation with no infiltration 
is based on the requirements in ASHRAE Standard 62.1 of 2.5 L/s per per-
son plus 0.30 L/s per m2 of floor area for a dwelling unit in a multi-family 
residential building. This entry is based on an assumed occupant density 
of 2 people per 100 m2 of floor area and a ceiling height of 2.4 m (7.9 ft). 
Other occupant densities and ceiling heights will correspond to different 
air change rates per the following formula: 

 Air change rate = 0.036 [2.5 D + 30] /H 

where: 

 D = number of occupants per 100 m2 of floor area 
 H = ceiling height in m. 

Like the other tables presented here, Table B5 includes mechanical venti-
lation, infiltration only and open windows. There is not an adequate body 
of ventilation measurements in multi-family residential buildings to use in 
supporting the values in this table, therefore all but the values based on 
Standard 62.1 are presented as very speculative. 

Table B5. Multi-family residential building air change rates 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 0.5    
Standard 62.1, under ventilation 0.25    
Standard 62.1, over ventilation 0.75    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  0.5 0.7 0.9 
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Average tightness  0.7 0.9 1.2 
Very leaky  0.9 1.2 1.5 

Mechanical combined with open windows 1.3 2.3 3.3 
Based on measured or design values, +/- 25% 
Very speculative, at least +/- 100% 

 

While the ventilation requirement in ASHRAE Standard 62.1 for multi-
family buildings is for an individual dwelling unit, the values in Table B5 
are presented as whole building values. It should be noted that individual 
units in a multi-family building may be characterized by very different 
ventilation rates than the whole building value. For example, under heat-
ing conditions, units located on the lower floors of a high-rise building are 
going to have much higher air change rates than those located on the up-
per floors, due to the stack effect. 

Retail, Restaurants and Theaters 

Tables B6B8 present the air change rate values for retail buildings, restau-
rants and theatres.  

The first entry in each table, under mechanical ventilation with no infiltra-
tion, is based on the requirements in ASHRAE Standard 62.1. These re-
quirements are 3.8 L/s per person in all three space types, plus 0.60 L/s 
per m2 of floor area in retail spaces, 0.90 L/s per m2 in restaurants and 
0.30 L/s per m2 in theaters. The default occupant density in the standard 
is 15 people per 100 m2 of floor area in retail spaces, 70 people per 100 m2 
in restaurants, and 100 people per 100 m2 in theaters. The assumed ceiling 
height is 2.4 m (7.9 ft) in retail and restaurants and 3.65 m (12.0 ft) in 
theaters. Other occupant densities and ceiling heights correspond to dif-
ferent air change rates per the following formulas: 

 Retail: Air change rate = 0.036 [3.8 D + 60] /H 

 Restaurants: Air change rate = 0.036 [3.8 D + 90] /H 

 Theaters: Air change rate = 0.036 [3.8 D + 30] /H 

where: 

 D = number of occupants per 100 m2 of floor area 
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 H = the ceiling height in m. 

The values in Tables B6B8 fall into three categories: mechanical ventila-
tion, infiltration only, and open windows. There is not a body of ventila-
tion rate measurements in retail spaces, restaurants, or theaters to use in 
supporting the values in these tables. Therefore, all but the values based 
on Standard 62.1 are presented as very speculative. 

Table B6. Retail air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 1.8    
Standard 62.1, under ventilation 0.9    
Standard 62.1, over ventilation 2.7    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  1.8 2 2.2 
Average tightness  2 2.2 2.5 
Very leaky  2.2 2.5 3 

Mechanical combined with open windows 2.5 3.5 4.5 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 

 
Table B7Restaurant air change rates 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 5    
Standard 62.1, under ventilation 2.5    
Standard 62.1, over ventilation 10    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
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Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  5 5.2 5.4 
Average tightness  5.2 5.4 5.7 
Very leaky  5.4 5.7 6 

Mechanical combined with open windows 5.8 6.8 7.8 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 

Table B8. Theater air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 4    
Standard 62.1, under ventilation 2    
Standard 62.1, over ventilation 6    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  4 4.2 4.4 
Average tightness  4.2 4.4 4.7 
Very leaky  4.4 4.7 5 

Mechanical combined with open windows 4.6 5.6 6.6 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 

 

Hospitals, Gymnasiums, Warehouses and Commissaries 

Tables B9B12 present the air change rate values for hospitals, gymna-
siums, warehouses, and commissaries. The first entry in each table, under 
mechanical ventilation with no infiltration, is based on the requirements 
in ASHRAE Standard 62.1. These requirements are 8 L/s to 15 L/s per per-
son in hospitals, depending on the type of room, with a default occupant 
density of 10 people to 20 people per 100 m2, again depending on the type 
of room. The ventilation requirements in gymnasiums and warehouses are 
1.5 L/s per m2 of floor area and 0.30 L/s per m2 respectively, with no de-
pendence on the number of occupants. The air change rates for commissa-
ries are based on the ventilation requirements for supermarkets in the 



ERDC/CERL TR-09-39 80 

 

standard, which are 3.8 L/s per person and 0.30 L/s per m2 of floor area, 
and a default occupant of 8 people per 100 m2. The assumed ceiling height 
is 2.4 m (7.9 ft) in hospital patient and treatment rooms and 3.65 m (12.0 
ft) in operating rooms and the other three building types.  

Other occupant densities and ceiling heights will correspond to different 
air change rates per the following formulas: 

 Hospitals: Air change rate = 6.1 D /H 
 Gymnasiums: Air change rate = 5.4 /H 
 Warehouses: Air change rate = 1.1 /H 
 Commissaries: Air change rate = 0.036 [3.8 D + 30] /H 

where: 

 D = number of occupants per 100 m2 of floor area 
 H = ceiling height in m 

The equation for hospitals is based on a generalized space type corres-
ponding to 10 L/s per person and an occupant density of 17 per 100 m2 of 
floor area. 

The values in Tables B9B 12 fall into three categories: mechanical ventila-
tion, infiltration only, and open windows only. There is not a body of venti-
lation rate measurements in hospitals, gymnasiums or warehouses to use 
in supporting the values in these tables, therefore all but the values based 
on Standard 62.1 are presented as very speculative. 

Table B9. Hospital air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 2.5    
Standard 62.1, under ventilation 1.3    
Standard 62.1, over ventilation 3.7    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
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 Weather 
independent Weather Weather 

independent Weather 

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  2.5 2.7 2.9 
Average tightness  2.7 2.9 3.3 
Very leaky  2.9 3.3 3.6 

Mechanical combined with open windows 3 4 5 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 

 

Table B10. Gymnasium air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 1.5    
Standard 62.1, under ventilation 0.8    
Standard 62.1, over ventilation 2.3    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  1.5 1.7 1.9 
Average tightness  1.7 1.9 2.3 
Very leaky  1.9 2.3 2.6 

Mechanical combined with open windows 2.2 3.2 4.2 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 
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Table B11. Warehouse air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 0.3    
Standard 62.1, under ventilation 0.2    
Standard 62.1, over ventilation 0.5    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  0.3 0.45 0.6 
Average tightness  0.45 0.6 1.0 
Very leaky  0.6 1.0 1.5 

Mechanical combined with open windows 1 2 3 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 

 
Table B12.Commissary air change rates. 

 Weather 
independent 

Weather 
Calm Moderate Severe 

Mechanical Ventilation     
Standard 62.1 rate no infiltration 0.9    
Standard 62.1, under ventilation 0.5    
Standard 62.1, over ventilation 1.4    

Infiltration Only     
Very tight building  0.1 0.25 0.5 
Average tightness  0.25 0.5 1.0 
Very leaky  0.5 1 1.5 

Open Windows Only  1 2 3 
     

Mechanical ventilation (Standard 62.1) combined with infiltration 
Very tight building  0.9 1.1 1.3 
Average tightness  1.1 1.3 1.5 
Very leaky  1.3 1.5 1.8 

Mechanical combined with open windows 1 2 3 
Based on measured or design values, ± 25% 
Very speculative, at least ± 100% 
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Summary 

The building air change rates presented in this report are based on a com-
bination of the ventilation requirements in ASHRAE Standard 62.1-2007, 
the very limited number of measurements conducted in the field, and a 
significant amount of engineering judgment. Any use of these rates must 
be fully informed by their limitations, particularly their lack of specificity 
to any particular building, system design, operating conditions or weather 
conditions, and by their limited basis in actual measurement. 

For many of the building types or conditions (e.g. open windows), few, if 
any, air change rate measurements even exist. Nevertheless, these rates 
may prove useful for certain types of analysis where there is no need to dif-
ferentiate between building types, system operation, and weather condi-
tions. The gaps noted in measured ventilation rates also highlight the need 
for more field studies and simplified calculation tools to determine build-
ing ventilation rates, particularly in buildings other than offices and resi-
dences. 
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